Read the Product Safety Guide first, then read the Quick Setup Guide for the correct setup procedure. After reading this guide, keep it in a safe place for quick reference.
Introduction

Important Notice

- The contents of this document and the specifications of this product are subject to change without notice.
- Brother reserves the right to make changes without notice in the specifications and materials contained herein and shall not be responsible for any damages (including consequential) caused by reliance on the materials presented, including but not limited to typographical and other errors relating to the publications.
- Screen images in this document may differ depending on your computer's operating system, your product model, and software version.
- Before using the Label Printer, make sure you read all the documents included with the Label Printer for information about safety and operation.
- The Label Printer shown in the illustrations may be different from your Label Printer.
- The available supplies may vary depending on the country.

Available Manuals

Visit the Brother Solutions Center at support.brother.com and click Manuals on your model page to download the latest manuals.

<table>
<thead>
<tr>
<th>Manual</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Safety Guide ¹</td>
<td>This guide provides safety information; read it before you use the Label Printer.</td>
</tr>
<tr>
<td>Quick Setup Guide ¹</td>
<td>This guide provides basic information about using the Label Printer along with troubleshooting tips.</td>
</tr>
<tr>
<td>User's Guide ²</td>
<td>This guide provides additional information about the Label Printer settings and operations, network connection and settings, troubleshooting tips, and maintenance instructions.</td>
</tr>
</tbody>
</table>

¹ Printed manual in the box
² PDF manual on the Brother Solutions Center website
Symbols Used in This Guide

The following symbols are used throughout this guide:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⚠️ WARNING</td>
<td>Indicates a potentially hazardous situation which, if the product is handled without following the warnings and instructions, could result in death or serious injuries.</td>
</tr>
<tr>
<td>⚠️ CAUTION</td>
<td>Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injuries.</td>
</tr>
<tr>
<td>IMPORTANT</td>
<td>Indicates information or directions that should be followed. Ignoring them may result in damage, or failed operations.</td>
</tr>
<tr>
<td>✍️ Note</td>
<td>Indicates notes that provide information or directions that can help you better understand and use the product more efficiently.</td>
</tr>
</tbody>
</table>
### General Precautions

<table>
<thead>
<tr>
<th>DK Roll (DK Label and DK Tape)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use only genuine Brother accessories and supplies (with 🅺 and 🅷 marks). DO NOT use any unauthorized accessories or supplies.</td>
</tr>
<tr>
<td>If the label is attached to a wet, dirty, or oily surface, it may peel off easily. Before applying the label, clean the surface to which the label will be applied.</td>
</tr>
<tr>
<td>DK Rolls use thermal paper or film that can fade in color or peel off surfaces if exposed to ultraviolet light, wind, or rain.</td>
</tr>
<tr>
<td>DO NOT expose the DK Rolls to direct sunlight, high temperatures, high humidity, or dust. Store in a cool, dark place. Use the DK Rolls soon after opening the package.</td>
</tr>
<tr>
<td>Scratching the printed surface of the label with your finger nails or metal objects, or touching the printed surface with damp or wet hands can cause the color to change or fade.</td>
</tr>
<tr>
<td>DO NOT apply labels to any persons, animals, or plants. In addition, never apply labels to public or private property without permission.</td>
</tr>
<tr>
<td>As the end of the DK Roll is designed to not adhere to the label spool, the last label may not be cut correctly. If this happens, remove the remaining labels, insert a new DK Roll, and reprint the last label. Note: To account for this, the number of DK Labels included on each DK Roll may be more than indicated on the package.</td>
</tr>
<tr>
<td>When a label is removed after being applied to a surface, a portion of the label may remain applied.</td>
</tr>
<tr>
<td>Prior to using CD/DVD labels, be sure to follow the instructions in your CD/DVD player’s instruction guide regarding applying CD/DVD labels.</td>
</tr>
<tr>
<td>DO NOT use CD/DVD labels in a slot loading CD/DVD player.</td>
</tr>
<tr>
<td>DO NOT peel off the CD/DVD label once it is applied to the CD/DVD, a thin surface layer may come off, resulting in damage to the disc.</td>
</tr>
<tr>
<td>DO NOT apply CD/DVD labels to CDs/DVDs designed for use with inkjet printers. Labels peel off these discs easily and using discs with peeling labels can result in loss or damage of data.</td>
</tr>
<tr>
<td>When applying CD/DVD labels, use the applicator included with the CD/DVD label rolls. Failure to do so could cause damage to the CD/DVD player.</td>
</tr>
<tr>
<td>Users shall take full responsibility for applying CD/DVD labels. Brother accepts no responsibility for any loss or damage of data caused by the inappropriate use of CD/DVD labels.</td>
</tr>
<tr>
<td>Be careful not to drop the DK Roll.</td>
</tr>
<tr>
<td>DK Rolls use thermal paper and thermal film. Both the label and print will fade with sunlight and heat. DO NOT use DK Rolls for any outdoor use that requires durability.</td>
</tr>
<tr>
<td>Depending on the area, material, and environmental conditions, the label may unpeel or become irremovable, or the color of the label may change or be transferred to other objects. Before applying the label, check the environmental conditions and the material. Test the label by affixing a small piece of it to an inconspicuous area of the intended surface.</td>
</tr>
<tr>
<td>If print results are not as expected, use the adjustment options in the printer driver or the Printer Setting Tool.</td>
</tr>
</tbody>
</table>
Table of Contents

Section I  Basic Operations

1  Set Up the Label Printer
   Parts Description .............................................................................................................. 2
   Front .......................................................................................................................... 2
   Rear........................................................................................................................... 3
   Connect the Power Cord .......................................................................................... 4
   Load the DK Roll....................................................................................................... 5
   Turn Power On/Off.................................................................................................... 8

2  Print Using a Computer (P-touch Editor)
   Install Printer Drivers and Software on a Computer .................................................. 9
   Connect the Label Printer to a Computer .................................................................. 10
      Connect Using a USB Cable .................................................................................. 10
      Connect Using Wi-Fi® ......................................................................................... 10
      Connect Using a Wired LAN.................................................................................. 14
      Bluetooth Connection ......................................................................................... 14
   Connect the Label Printer to a Barcode Scanner using Bluetooth (Windows® only) .... 15
   Print from a Computer ............................................................................................ 16
      Available Applications........................................................................................... 16
      Create Labels from Your Computer ....................................................................... 17
      Attach Labels........................................................................................................ 18

3  Print Using a Mobile Device
   Install Applications for Use with Mobile Devices.................................................... 19
      Available Applications........................................................................................... 19
   Connect the Label Printer to a Mobile Device ......................................................... 19
      Connect Using Wireless Direct ........................................................................... 19
      Connect Using Bluetooth .................................................................................... 20
   Print Labels from a Mobile Device .......................................................................... 21
      Use a Mobile Device to Print Templates Created on a Computer ......................... 21
      Attach Labels........................................................................................................ 22

4  Change the Label Printer Settings
   Printer Setting Tool for Windows® ............................................................................ 23
      Before Using the Printer Setting Tool .................................................................. 23
   Use the Printer Setting Tool for Windows® .............................................................. 24
      Communication Settings for Windows® ............................................................... 26
         Settings Dialog Box ......................................................................................... 26
         Menu Bar ........................................................................................................... 28
         General Tab ....................................................................................................... 30
         Wired LAN / Wireless LAN Tabs ...................................................................... 31
         Wireless Direct Tab .......................................................................................... 33
         Bluetooth Tab ................................................................................................. 34
5 Print Labels Using P-touch Template

P-touch Template Operations ........................................................................................................ 50
Preparation .................................................................................................................................. 51
  Specify Settings in the P-touch Template Settings Tool .......................................................... 51
Connect a Barcode Scanner ............................................................................................................. 53
Standard Template Printing .......................................................................................................... 54
Advanced Template Printing ......................................................................................................... 56
Database Lookup Printing .............................................................................................................. 59
Numbered (Serialized Number) Printing ....................................................................................... 62
  Text Numbering (Serializing) ..................................................................................................... 62
  Barcode Numbering (Serializing) ............................................................................................... 63
Print with Numbering (Serializing) Advanced Operation ............................................................. 64

6 Other Functions

Confirm Label Printer Settings ........................................................................................................ 65
Crop Print (Print Barcode Labels) (Windows® only) ...................................................................... 65
  Barcodes Compatible with Crop Print .......................................................................................... 66
Create a Barcode Document to Use with Crop Print .................................................................... 66
Print Barcode Labels Using Crop Print .......................................................................................... 67
Mass Storage Mode ......................................................................................................................... 70
  Description .................................................................................................................................. 70
Use the Mass Storage Mode ............................................................................................................ 71
JPEG Printing .................................................................................................................................. 72
Distributed Printing (Windows® only) ............................................................................................. 73
### Section II Application

#### 7 How to Use P-touch Editor

For Windows®
Starting P-touch Editor
Printing with P-touch Editor
Transfer Data to the Label Printer
For Mac
Start P-touch Editor
Operation modes
Transfer Data to the Label Printer

#### 8 How to Use the P-touch Address Book (Windows® only)

Start the P-touch Address Book
Create a New Contact

#### 9 How to Use P-touch Editor Lite LAN (Windows® only)

#### 10 How to Use P-touch Transfer Manager and P-touch Library (Windows® only)

P-touch Transfer Manager
Transfer the Template to P-touch Transfer Manager
Transfer Templates or Other Data from the Computer to the Label Printer
Back up Templates or Other Data Saved in the Label Printer
Delete Label Printer Data
Create Transfer Files and Transfer Package Files
P-touch Library
Start P-touch Library
Open and Edit Templates
Print Templates
Search for Templates

#### 11 How to Transfer Templates with P-touch Transfer Express (Windows® only)

Preparing P-touch Transfer Express
Transfer the Template to P-touch Transfer Manager
Save the Template as a Transfer Package File (.pdz)
Distribute the Transfer Package File (.pdz) and P-touch Transfer Express to Others
Transfer the Transfer Package File (.pdz) to Your Label Printer

#### 12 How to Update P-touch Software

Update P-touch Editor and P-touch Address Book (Windows® only)
Update the Firmware
For Windows®
For Mac
# Section III Network

## 13 Introduction

Network Features ........................................................................................................................................ 125

## 14 Change Your Label Printer Network Settings

Change Your Label Printer's Network Settings (IP Address, Subnet Mask, and Gateway) ................................. 126
Using the BRAdmin Light Utility (Windows® only) ...................................................................................... 126
Other Management Utilities ........................................................................................................................ 128
Using the BRAdmin Professional Utility (Windows® only) ........................................................................... 128

## 15 Web Based Management

Overview ......................................................................................................................................................... 129
Configure the Printer Settings Using Web Based Management (Web Browser) ............................................. 130

# Section IV Appendix

## 16 Reset the Label Printer

Reset All Settings to the Factory Settings Using the Label Printer Buttons ....................................................... 132
Reset Data Using the Printer Setting Tool ...................................................................................................... 132

## 17 Maintenance

Clean the Exterior of the Unit .......................................................................................................................... 133
Clean the Label Outlet ..................................................................................................................................... 133
Clean the Roller .................................................................................................................................................. 134
Self-Cleaning Print Head .................................................................................................................................. 134

## 18 Troubleshooting

Overview ............................................................................................................................................................ 135
LED Indications .................................................................................................................................................. 136
Printing Problems .............................................................................................................................................. 138
Network Setup Problems ................................................................................................................................. 143
Label Printer Cannot Print over the Network
  Label Printer Is Not Found on the Network Even after Successful Installation ........................................ 145
Security Software Problems ............................................................................................................................ 145
Checking the Operation of Network Devices ................................................................................................. 146
Version Information .......................................................................................................................................... 146

## 19 Product Specifications

Label Printer Specifications ............................................................................................................................... 147
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>Software Development Kit</td>
<td>149</td>
</tr>
<tr>
<td>21</td>
<td>Notes on Using P-touch Transfer Manager</td>
<td>150</td>
</tr>
<tr>
<td></td>
<td>Notes on Creating Templates</td>
<td>150</td>
</tr>
<tr>
<td></td>
<td>Notes on Transferring Templates</td>
<td>150</td>
</tr>
<tr>
<td></td>
<td>Notes on Transferring Data Other Than Templates</td>
<td>151</td>
</tr>
<tr>
<td>22</td>
<td>Network Terms and Information</td>
<td>152</td>
</tr>
<tr>
<td></td>
<td>Supported Protocols and Security Features</td>
<td>152</td>
</tr>
<tr>
<td></td>
<td>Types of Network Connections and Protocols</td>
<td>153</td>
</tr>
<tr>
<td></td>
<td>Types of Network Connections</td>
<td>153</td>
</tr>
<tr>
<td></td>
<td>Configure Your Label Printer for a Network</td>
<td>155</td>
</tr>
<tr>
<td></td>
<td>IP Addresses, Subnet Masks and Gateways</td>
<td>155</td>
</tr>
<tr>
<td></td>
<td>Wireless Network Terms and Concepts</td>
<td>157</td>
</tr>
<tr>
<td></td>
<td>Security Terms</td>
<td>157</td>
</tr>
<tr>
<td>23</td>
<td>List of Barcodes for the P-touch Template Function</td>
<td>161</td>
</tr>
<tr>
<td></td>
<td>General Procedure for the P-touch Template Function</td>
<td>161</td>
</tr>
<tr>
<td></td>
<td>List of Barcodes for Specifying Settings</td>
<td>162</td>
</tr>
<tr>
<td>24</td>
<td>Use the Brother Barcode Scanner (Optional: PA-BR-001)</td>
<td>165</td>
</tr>
</tbody>
</table>
Basic Operations

Set Up the Label Printer 2
Print Using a Computer (P-touch Editor) 9
Print Using a Mobile Device 19
Change the Label Printer Settings 23
Print Labels Using P-touch Template 50
Other Functions 65
1 Set Up the Label Printer

Parts Description

Front

1 Status LED
2 Power Button
3 Feed Button
4 Cutter Button
5 Bluetooth Button
6 Wi-Fi Button
7 WPS Button
8 Wi-Fi LED
9 Bluetooth LED
10 Label Output Slot
11 DK Roll Compartment Cover
Set Up the Label Printer

**Rear**

1. USB Port
2. LAN Port
3. USB Host Port
4. AC Power Port
Connect the Power Cord

Connect the AC Power Cord to the Label Printer. Then, plug the AC Power Cord into a grounded AC power outlet.

IMPORTANT

Do not use your Label Printer in areas where the power source voltage is different from the Label Printer's specified voltage. For more information, see Product Specifications on page 147.
Load the DK Roll

1. Make sure that the Label Printer is turned Off.
2. Pull the release levers on both sides of the Label Printer to unlock the DK Roll Compartment Cover.
   • Hold the Label Printer by the front, and firmly lift the DK Roll Compartment Cover to open it.

IMPORTANT
Before using the Label Printer, remove the protective sheet (1) from the Label Output Slot.
3 Place the DK Roll into the Roll Spool Guide (1).
   • Make sure that the Roll Spool Arm (2) is inserted firmly in the Roll Spool Guide.
   • Make sure the Stabilizer (3) slides into the notch of the Label Printer.

4 Thread the DK Roll through the Label Printer.
   • Align the edge of the DK Roll with the upright edge of the Label Output Slot.
   • Check that the DK Roll is threaded straight so that the labels will not be skewed.

   • Push the first label through the Label Output Slot until the end comes out of the Slot as shown.

**Note**
If you have difficulty inserting the first label, try inserting from the side under the sensor (1).
Close the DK Roll Compartment Cover.

**IMPORTANT**
- Do not leave any printed labels in the Label Printer. Doing so will cause the labels to jam.
- When not in use, remove any DK Rolls from inside the Label Printer and close the DK Roll Compartment Cover to prevent dust and debris from accumulating in the Label Printer.
Set Up the Label Printer

## Turn Power On/Off

**On:** Press the Power () Button to turn the Label Printer On. The Status LED turns green.

**IMPORTANT**
Press the Feed () Button to align the end of the DK Roll.

**Off:** Press and hold the Power () Button again to turn the Label Printer Off.

**IMPORTANT**
When turning the Label Printer Off, do not disconnect the AC Power Cord until the orange Status LED turns Off.
Install Printer Drivers and Software on a Computer

To print from your Windows® computer or Mac, install the printer drivers, P-touch Editor, and other applications to your computer.

**Software for Windows®:**
- Printer Driver
- P-touch Editor
- P-touch Address Book
- P-touch Update Software
- Printer Setting Tool
- BRAdmin Light
- BRAdmin Professional

**Software for Mac:**
- Printer Driver
- P-touch Editor
- P-touch Update Software
- Printer Setting Tool
- Wireless Device Setup Wizard

1. Visit our website (install.brother) and download the Software Installer for the latest software and manuals.

2. Double-click the downloaded EXE file (for Windows®) or DMG file (for Mac), and follow the on-screen instructions to proceed with the installation.

### Note

To connect the Label Printer to a computer using a wireless connection, we recommend the following:

- When you turn on the Label Printer for the first time after purchasing it or after resetting it, the Label Printer enters the mode for configuring the wireless settings easily. Start the installation after turning on the Label Printer.
- Make a note of the SSID (network name) and password (network key) of the wireless network in advance. If you cannot find this information, ask your network administrator or wireless access point/router manufacturer.
- To connect the Label Printer to a computer using Wireless Direct, select USB connection during the installation. At the end of the installation, click the link for Wireless Direct following the on-screen instructions.

3. Close the dialog box when the installation is complete.

### Note

To use the Label Printer with a different connection method than the one selected during installation, use the installer again to reinstall the software and printer drivers, and select the new connection method.
Connect the Label Printer to a Computer

Refer to these directions for the type or connection method:

- USB Cable connection
  See Connect Using a USB Cable on page 10.

- Wireless LAN connection
  See Connect Using Wi-Fi® on page 10.

- Wired LAN connection
  See Connect Using a Wired LAN on page 14.

- Bluetooth Connection
  See Bluetooth Connection on page 14.

Connect Using a USB Cable

1. Make sure the Label Printer is turned Off before connecting the USB Cable.

2. Connect the USB Cable to the USB Port on the back of the Label Printer, and then to your computer.

3. Turn the Label Printer On.

Connect Using Wi-Fi®

The following Wi-Fi connection methods are available:

- Infrastructure Mode
- Wireless Direct
- WPS (Wi-Fi Protected Setup™)

Infrastructure Mode

Infrastructure Mode allows you to connect the Label Printer to a computer via a Wi-Fi access point/router.

Before You Begin

First, you must configure the Wi-Fi settings of the Label Printer to communicate with your Wi-Fi access point/router. After the Label Printer is configured, computers on your network will have access to the Label Printer.
IMPORTANT

• If you are going to connect the Label Printer to your network, we recommend that you contact your system administrator before installation. You must confirm your Wi-Fi settings before you proceed with this installation.

• To configure the Wi-Fi settings again, or if the status of the Wi-Fi connection for the Label Printer is unknown, reset the Wi-Fi settings of the Label Printer. For more information on resetting the settings, see Reset the Label Printer on page 132.

• When you turn on the Label Printer for the first time after purchasing it or after resetting it, the Label Printer enters the mode for configuring the wireless settings easily. Start the installation after turning on the Label Printer.

Note
To achieve the best results with normal everyday printing, use the Label Printer as close to the Wi-Fi access point/router as possible with minimal obstructions. Large objects and walls between the two devices as well as interference from other electronic devices can affect communication, or the data transfer speed of your printing.

Connect the Label Printer to your Wi-Fi access point/router

1 First, write down the SSID (network name) and password (network key) of your Wi-Fi access point/router.

2 Turn the Label Printer on.

3 Start the installation and proceed according to the on-screen instructions.

Note
If the screen for selecting the network appears, select the SSID that you wrote down.

4 When the connection between the Label Printer and your Wi-Fi access point/router is established, computers that are on the same network as the Label Printer will have access to the Label Printer.
Wireless Direct

Wireless Direct allows you to connect the Label Printer to your computer directly without a Wi-Fi access point/router; the printer serves as a Wi-Fi access point.

1. Follow the on-screen instructions to select connecting via USB and proceed with the installation.
2. Set the Label Printer to Wireless Direct mode.

   - For Windows®
     1. Launch the Printer Setting Tool on your computer.
     2. Click the Communication Settings button.
     3. Click the Communication Settings in the General tab.
     4. Confirm Infrastructure and Wireless Direct or Wireless Direct is selected for Selected Interface, and then confirm the Wireless Direct tab.
     5. Click Apply to set the Label Printer to Wireless Direct mode.
     6. Press and hold the Wi-Fi Button on your Label Printer for one second to turn on the Wi-Fi function. The Wi-Fi LED starts flashing green once every three seconds.

   - For Mac
     1. Launch the Printer Setting Tool on your computer.
     2. Click the Wireless LAN tab.
     3. Confirm that Wireless Direct is set to On.
     4. Click Apply to set the Label Printer to Wireless Direct mode.

3. Use your computer to select the SSID of the Label Printer. Make sure that your computer and the Label Printer are connected via wireless connection.

   - For Windows®
     The printer must be added to the computer. Follow the on-screen instructions to add the printer.

   - For Mac

Note

The Label Printer's default SSID is: "DIRECT-*****_QL-1110NWB", where ***** is the last five digits of the product serial number. The Label Printer’s default password is: 111*****, where ***** is the last five digits of the product serial number.

- The Printer Setting Tool also allows you to apply the network settings changes to multiple Label Printers. For more information, see Apply Setting Changes to Multiple Label Printers on page 35.
- You cannot connect to the Internet on your computer via Wi-Fi while using Wireless Direct.
**WPS (Wi-Fi Protected Setup™)**

If your Wi-Fi access point/router supports WPS, settings and connections can be configured quickly.

1. First, confirm that your Wi-Fi access point/router has the WPS symbol.

2. Place the Label Printer within the range of your Wi-Fi access point/router. The range may differ depending on your environment. See the instructions provided with your Wi-Fi access point/router.

3. Press the WPS Button on the Label Printer. When the connection is established, the Wi-Fi LED is lit green.

**Note**

- Computers that are on the same network as the Label Printer will have access to the Label Printer.
- The Label Printer will try to connect using WPS for two minutes. If the WPS Button is pressed during that time, the Label Printer will continue trying to connect for an additional two minutes.
Connect Using a Wired LAN

**Note**
To use a static IP address to connect your Label Printer to a wired LAN connection, install the printer drivers and Printer Setting Tool, and then specify the wired LAN connection settings.
For more information, see *Install Printer Drivers and Software on a Computer* on page 9.

1. If on-screen instructions appear during installing, make sure the Label Printer is turned Off before connecting the LAN cable.
2. Connect the LAN cable to the LAN Port on the back of the Label Printer.
3. Turn the Label Printer On.

**Network Cable**
Use a straight-through Category 5 (or greater) twisted-pair cable for 10BASE-T or 100BASE-TX Fast Ethernet Network.

**Note**
Do not connect this product to any LAN connection that is subject to overvoltages.

**Bluetooth Connection**

1. Press the Bluetooth (Bluetooth) Button on the Label Printer. The Bluetooth LED is lit blue.
   - For Windows®
     1. Follow the on-screen instructions to proceed with the installation.
     2. When the search results appear, select the Label Printer. Bluetooth communication starts.
   - For Mac
     1. Select USB connection for installation.
     2. When you turn on the Bluetooth connection in the Mac after installation, the Mac finds the Label Printer you want to set up.
Connect the Label Printer to a Barcode Scanner using Bluetooth (Windows® only)

You can connect the Label Printer to a Barcode Scanner using a Bluetooth interface.

**Note**
- Follow the recommendations of the manufacturer of your Bluetooth-equipped devices, such as Barcode Scanners, and install any necessary hardware and software.
- The Bluetooth connection settings are saved even after the Label Printer is turned off.

### Connect the Label Printer to a Barcode Scanner using Bluetooth

To print barcodes using a Bluetooth connection you must perform the following steps:

Once a connection has been established, the Label Printer remains connected until it is turned off, preventing it from connecting to another device.

1. Press the Bluetooth (Bluetooth) button. The Bluetooth LED lights in blue.

2. Execute pairing from a destination Bluetooth device.
   - If the PIN code of the Label Printer is required, the factory setting for the PIN code is the last four digits of the product serial number.
   - You can change the PIN code using the Communication Setting Tool.

3. When the **Request Secure Simple Pairing (SSP) settings during pairing** check box is not selected in the Bluetooth tab of Communication Settings, the Bluetooth connection is made.

   When the **Request Secure Simple Pairing (SSP) settings during pairing** check box is selected in the Bluetooth tab of Communication Settings, press the Bluetooth (Bluetooth) button on the Label Printer during the Bluetooth LED is flashing in blue.
Print from a Computer

Available Applications

To use the Label Printer effectively, a number of applications and functions are available. You must install the printer driver to use these applications. Visit our website (install.brother) and download the installer for the applications and printer driver.

<table>
<thead>
<tr>
<th>Application</th>
<th>Windows</th>
<th>Mac</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>P-touch Editor</td>
<td>✓</td>
<td>✓</td>
<td>Designs and prints custom labels with built-in drawing tools, text using different fonts and styles, imported graphic images, and barcodes.</td>
</tr>
<tr>
<td>P-touch Transfer Manager</td>
<td>✓</td>
<td></td>
<td>Allows you to transfer templates and other data to the Label Printer and save backups of your data on the computer. This application is installed with P-touch Editor.</td>
</tr>
<tr>
<td>P-touch Library</td>
<td>✓</td>
<td></td>
<td>Manages and prints P-touch Editor templates. You can use P-touch Library to print templates. This application is installed with P-touch Editor.</td>
</tr>
<tr>
<td>P-touch Update Software</td>
<td>✓</td>
<td>✓</td>
<td>Updates software to the latest version.</td>
</tr>
<tr>
<td>P-touch Address Book</td>
<td>✓</td>
<td></td>
<td>Prints address labels using an address database.</td>
</tr>
<tr>
<td>P-touch Editor Lite LAN</td>
<td>✓</td>
<td></td>
<td>Prints over both wireless and wired connections. There is no need to install the printer driver.</td>
</tr>
<tr>
<td>Printer Setting Tool</td>
<td>✓</td>
<td>✓</td>
<td>Specifies the Label Printer’s device settings from a computer.</td>
</tr>
<tr>
<td>Wireless Device Setup Wizard</td>
<td></td>
<td>✓</td>
<td>Allows you to configure the Label Printer for a wireless network.</td>
</tr>
<tr>
<td>BRAdmin Light</td>
<td>✓</td>
<td></td>
<td>Finds the Label Printer on your network and allows you to configure basic settings from your computer.</td>
</tr>
<tr>
<td>BRAdmin Professional</td>
<td>✓</td>
<td></td>
<td>Finds the Label Printer on your network and allows you to configure advanced settings and updates from your computer.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Function</th>
<th>Windows</th>
<th>Mac</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crop Print</td>
<td>✓</td>
<td></td>
<td>This Label Printer can print one or multiple barcodes from a Letter/A4 sized .pdf file. It will automatically identify and individually crop and print barcodes.</td>
</tr>
<tr>
<td>Distributed Printing</td>
<td>✓</td>
<td></td>
<td>When printing a large number of labels, printing can be distributed among multiple Label Printers. Because printing is performed at the same time, the total printing time can be reduced. For more information, see Distributed Printing (Windows® only) on page 73.</td>
</tr>
</tbody>
</table>
Create Labels from Your Computer

There are various methods for printing with this Label Printer. The following describes the procedure for printing from a computer using P-touch Editor or P-touch Address Book.

1. Start P-touch Editor or P-touch Address Book, and then open the document you want to print.
2. Create a label design.
3. Check the cutting options.
4. Select File > Print or by clicking the Print icon.

Cutting Options

The cutting options allow you to specify how the item is fed and cut when it is printed. Use the printer driver to select the cutting option when printing from the computer.

Label Cut Option Table

<table>
<thead>
<tr>
<th>Auto Cut</th>
<th>Cut at End</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>Yes</td>
<td>ABC</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>ABC</td>
</tr>
<tr>
<td>Yes</td>
<td>Yes or No</td>
<td>ABC</td>
</tr>
</tbody>
</table>
Attach Labels

1. Peel the backing from the label.
2. Position the label, and then press firmly from top to bottom with your finger to attach the label.

Note
Labels may be difficult to attach to surfaces that are wet, dirty, or uneven. The labels may peel off easily from these surfaces.
Install Applications for Use with Mobile Devices

Brother offers various apps that allow you to print directly from your iPhone, iPad, and iPod touch or Android™ smartphone or tablet. We also offer apps that allow you to transfer data, such as templates, symbols, and databases created using a computer, wirelessly to your Label Printer.

Available Applications

Download these free Brother apps from Google Play:

<table>
<thead>
<tr>
<th>Application</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brother iPrint&amp;Label</td>
<td>This application allows you to create and print labels from templates, using a mobile device.</td>
</tr>
<tr>
<td>Mobile Transfer Express</td>
<td>This application allows you to use a mobile device to download databases and label data, created on a computer using P-touch Editor and saved to a cloud service, and send them to your Label Printer.</td>
</tr>
</tbody>
</table>

Connect the Label Printer to a Mobile Device

Connect Using Wireless Direct

1. Confirm the Wireless Direct settings of the Label Printer, and then connect the Label Printer to your computer using a USB On-the-Go cable ¹.

¹ Sold separately

- For Windows®
  1. Launch the Printer Setting Tool on your computer.
  2. Click the Communication Settings button.
  3. Click the Communication Settings in the General tab.
  4. Confirm Infrastructure and Wireless Direct or Wireless Direct is selected for Selected Interface. If not, select Infrastructure and Wireless Direct or Wireless Direct and click the Apply button.

- For Mac
  1. Launch the Printer Setting Tool on your computer.
  2. Click the Communication Settings button.
  3. Click the Wireless LAN tab.
  4. Confirm that Wireless Direct is set to On.

2. Press and hold the Wi-Fi (_INET) Button on the Label Printer for one second to turn the Wi-Fi function On. The Wi-Fi LED starts flashing green at every three second intervals.
In your mobile device's Wi-Fi settings screen, select your wireless network's SSID, and then SSID of the Label Printer and enter the password.

**Note**

- The factory default SSID and password are as follows:
  SSID: "DIRECT-*****_QL-1110NWB" where ***** is the last five digits of the product serial number.
  The password: 111***** where ***** is the last five digits of the product serial number.
- You can connect the Label Printer to a mobile device in the Infrastructure Mode via a wireless access point/router.

**Connect Using Bluetooth**

1. Press the Bluetooth (ﾎﾞuve) Button. The Bluetooth LED lights blue.
2. In your mobile device's Bluetooth settings screen, select your printer.
Print Labels from a Mobile Device

1. Start the mobile printing application on your mobile device.

   **Note**
   Make sure that the Label Printer is connected to your mobile device via a wireless connection. See *Connect the Label Printer to a Mobile Device* on page 19.

2. Select a label template or design.

   **Note**
   You can also select a previously designed label or image and print it.

3. Tap *Print* in the application menu.

Cutting Options

See *Cutting Options* on page 17.

Use a Mobile Device to Print Templates Created on a Computer

You can use P-touch Transfer Manager to save template data, which was created using P-touch Editor, in .blf or .pdz format. Then, you can use Mobile Transfer Express to send the saved file from your mobile device to the Label Printer and print the file.

1. Save the template data in .blf or .pdz format using P-touch Transfer Manager. For more information, see *Create Transfer Files and Transfer Package Files* on page 103.

2. Use one of the following methods to use a .blf file or .pdz file with your mobile device.

   - Save the file using a cloud storage service, and then use the sharing function of the mobile device’s operating system to share the file.
   - Send the file as an email attachment from the computer to the mobile device, and then save the file to the mobile device.

3. Connect the Label Printer to your mobile device, and then start Mobile Transfer Express. The template data appears.

4. Select the template that you want to print, and then transfer the template to the Label Printer.

   **Note**
   To download a file from a cloud storage service to your mobile device, you must connect your mobile device using Infrastructure Mode. Therefore, if you also connect your mobile device to the Label Printer using Infrastructure Mode, you can quickly transfer downloaded files (.blf files only).

5. Use the Barcode Scanner to select the template that you want to print from the transferred file and print it.
Attach Labels

1. Peel the backing from the label.

2. Position the label, and then press firmly from top to bottom with your finger to attach the label.

Note

Labels may be difficult to attach to surfaces that are wet, dirty, or uneven. The labels may peel off easily from these surfaces.
4 Change the Label Printer Settings

Printer Setting Tool for Windows®

Use the Printer Setting Tool to specify the Label Printer's communication settings, device settings and P-touch Template settings from a Windows® computer.

드리 Note
The Printer Setting Tool is installed automatically when you use the initial installer to install the printer driver. For more information, see Install Printer Drivers and Software on a Computer on page 9.

IMPORTANT
The Printer Setting Tool is available only with compatible Brother printers.

Before Using the Printer Setting Tool

- Make sure the AC Power Cord is connected to the Label Printer and to an AC power outlet.
- Make sure the printer driver has been installed correctly and you can print.
- Connect the Label Printer to a computer with a USB Cable.
Use the Printer Setting Tool for Windows®

1. Connect the Label Printer you want to configure to the computer.
2. Start the Printer Setting Tool.

   - **For Windows® 7 / Windows Server® 2008 / Windows Server® 2008 R2:**
     Click **Start > All Programs > Brother > Labels & Mobile Printer > Printer Setting Tool.**

   - **For Windows® 8 / Windows® 8.1 / Windows Server® 2012 / Windows Server® 2012 R2:**
     On the **Apps** screen, click the **Printer Setting Tool.**

   - **For Windows® 10 / Windows Server® 2016:**
     Click **Start > Brother > Printer Setting Tool.**

     The main window appears.

     ![Printer Setting Tool window with labels 1 to 5]

     1. **Printer**
        Lists the connected Label Printers.

     2. **Communication Settings**
        Specifies wired LAN, wireless LAN and Bluetooth communication settings.

     3. **Device Settings**
        Specifies device settings, such as power settings and printer settings.

     4. **P-touch Template Settings**
        Specifies P-touch Template settings.
        For more information on P-touch Template, download the *P-touch Template Manual/Command Reference* (English only) from the Brother Solutions Center at support.brother.com/manuals.

     5. **Exit**
        Closes the window.
Check that the Label Printer you want to configure appears next to **Printer**. If a different Label Printer appears, select the Label Printer you want from the drop-down list.

Select the settings you want to change, and then specify or change the settings in the dialog box. For more information on the settings dialog boxes, see *Communication Settings for Windows®* on page 26, *Device Settings for Windows®* on page 36 or *P-touch Template Settings for Windows®* on page 41.

Click **Apply** to apply the settings to the Label Printer.

Click **Exit** in the main window to finish specifying settings.

**IMPORTANT**

Use the Printer Setting Tool to configure the Label Printer *only* when the Label Printer is idle. The Label Printer may malfunction if you try to configure it while it is processing or printing a print job.
Communication Settings for Windows®

Use Communication Settings in the Printer Setting Tool to specify or change the Label Printer communication information, when connecting the Label Printer and computer with a USB Cable or via a Bluetooth connection. Not only can you change the communication settings for one Label Printer, but you can also apply the same settings to multiple Label Printers.

Settings Dialog Box

1 Disable these settings
When this check box is selected, appears in the tab, and the settings can no longer be specified or changed.

Settings in a tab where appears will not be applied to the Label Printer even if Apply is clicked. In addition, the settings in the tab will not be saved or exported when the Save in Command File or Export command is used.
To apply the settings to the Label Printer, or to save or export them, make sure you clear the check box.

2 Items
When Current Status is selected, the current settings appear in the settings display/change area. Select the item for the settings that you want to change.

3 Menu Bar
Commands are categorized under each menu (File, Tools, and Help) by function.

4 Printer
Lists the connected Label Printers.
5 **Node Name**
Displays the node name (nodes can be renamed). For more information, see *Menu Bar* on page 28.

6 **Settings Tabs**
Contains settings that may be specified or changed.
If ![lock] appears in the tab, the settings in that tab will not be applied to the Label Printer.

7 **Settings Display/Change Area**
Displays the current settings for the selected item.

8 **Refresh**
Updates the displayed settings with the most recent information.

9 **Exit**
Exits *Communication Settings*, and returns to the main window of the Printer Setting Tool.

**IMPORTANT**
Settings are not applied to Label Printers if **Exit** is clicked without clicking the **Apply** button after changing the settings.

10 **Apply**
Applies the settings to the Label Printer.
To save the specified settings in a command file, select **Save in Command File** from the drop-down list.
The saved command file can be used with the mass storage mode to apply the settings to a Label Printer.
For more information, see *Mass Storage Mode* on page 70.

**IMPORTANT**
Clicking **Apply** applies all settings in all tabs to the Label Printer.
If the **Disable these settings** check box is selected, the settings in that tab are not applied.
Menu Bar

• **Apply Settings to the Printer**
  Applies the settings to the Label Printer.

• **Save Settings in Command File**
  Saves the specified settings in a command file. The file extension is .bin.
  The saved command file can be used with the mass storage mode to apply the settings to a Label Printer.
  For more information, see *Mass Storage Mode* on page 70.

⚠️ **Note**
If the **Disable these settings** check box is selected, the settings in that tab are not saved.

**IMPORTANT**

- The following information is not saved with the command file:
  - Node name
  - IP address, subnet mask and default gateway (when the IP address is set to **STATIC**)
  - The saved communication settings commands are intended to be used only for applying settings to a Label Printer. To apply the settings to the Label Printer using this command file, use the mass storage mode.
  - Saved command files contain authentication keys and passwords. Take necessary measures to protect saved command files, such as saving them in a location that cannot be accessed by other users.
  - Do not send command files to a different printer model.

• **Import**
  - **Import from the current computer wireless settings**
    Imports the settings from the computer.

⚠️ **Note**
- When importing the computer’s wireless settings, administrator privileges for the computer are needed.
- Only personal security authentication settings (open system, public key authentication and WPA/WPA2-PSK) can be imported. Enterprise security authentication (such as LEAP and EAP-FAST), WPA2-PSK (TKIP) and WPA-PSK (AES) settings cannot be imported.
- If multiple wireless LANs are enabled for the computer you use, the first wireless settings (only personal settings) that are detected will be considered for the import data.
- Only the settings (communication mode, SSID, authentication method, encryption mode and authentication key) from the **Wireless LAN** tab - **Wireless Settings** pane can be imported.

  - **Select a Profile to import**
    Imports the exported file and applies the settings to a Label Printer.
    Click **Browse** and select the file you want to import. The settings in the selected file appear in the settings display/change area.
Note

• All settings, such as wireless settings or TCP/IP settings, can be imported, except for node names.
• Only profiles that are compatible with the selected Label Printer can be imported.
• If the imported profile’s IP address is set to STATIC, change the IP address of the imported profile, if needed, so that it does not duplicate the IP address of an existing configured Label Printer on the network.

• Export
  Saves the current settings in a file.
  If the Disable these settings check box is selected the settings in that tab are not saved.

IMPORTANT

Exported files are not encrypted.

• Automatically restart the printer after applying new settings
  If this check box is selected, the Label Printer automatically restarts after communication settings are applied.
  If this check box is cleared, you must restart the Label Printer manually.

Note

When configuring multiple Label Printer’s, you can reduce the time needed to change settings by clearing this check box. In this case, we recommend selecting this check box when configuring the first Label Printer so that you can confirm that each setting is operating as intended.

• Automatically detects the connected printer, and retrieves the current settings
  If this check box is selected and a Label Printer is connected to the computer, the Label Printer is automatically detected and the Label Printer’s current settings are displayed in the Current Status pane.

Note

If the model of the connected Label Printer is different from that of the Label Printer shown in the Printer drop-down list, the settings available on all tabs change to match the connected Label Printer.

• Change Node Name/Bluetooth Device Name
  Allows renaming a node.

• Reset to Default Communication Settings
  Returns the communication settings to their factory settings.

• Display Help
  Displays the Help topics.
General Tab

Communication Settings
• Network Settings on Power On
  Specifies the conditions for connecting via Wi-Fi when the Label Printer is turned on.
  Select Wireless LAN by Default, Wired LAN by Default or Keep Current State.
• Selected Interface
  Selects Infrastructure or Ad-hoc, Infrastructure and Wireless Direct or Wireless Direct.
• Bluetooth on Power On
  Specifies the conditions for connecting via Bluetooth when the Label Printer is turned on.
  Select On by Default, Off by Default or Keep Current State.

IPv6
• IPv6 usage
  Selects Enable or Disable.
• Priority on IPv6 address
  Selects to give priority to an IPv6 address.
Wired LAN / Wireless LAN Tabs

TCP/IP (Wired/Wireless)

- **Boot Method**
  Selects AUTO, BOOTP, DHCP, RARP, or STATIC.

- **IP Address/Subnet Mask/Gateway**
  Specifies the various networking values.
  You can enter these settings only when the IP address is set to STATIC.

- **DNS Server Method**
  Selects AUTO or STATIC.

- **Primary DNS Server IP Address/Secondary DNS Server IP Address**
  You can enter these settings only when the DNS server is set to STATIC.

IPv6

- **Static IPv6 Address**
  Specifies a permanent IPv6 address.

- **Enable this address**
  Enables the specified static IPv6 address.

- **Primary DNS Server IPv6 Address/Secondary DNS Server IPv6 Address**
  Specifies the DNS server IPv6 addresses.

- **IPv6 Address List**
  Displays the list of IPv6 addresses.

Wireless Settings

- **Communication Mode**
  Selects Infrastructure or Ad-hoc.

- **SSID (Network Name)**
  Clicking Search displays the available SSID selections in a separate dialog box.

- **Channel**
  Lists available channels.

  **Note**
  This setting is valid only in Ad-Hoc mode.

- **Authentication Method/Encryption Mode**
  The supported encryption modes for the authentication methods are as shown in Communication Modes and Authentication Methods/Encryption Modes on page 32.

- **WEP Key**
  You can specify a setting only when WEP is selected as the encryption mode.

- **Passphrase**
  You can specify a setting only when WPA/WPA2-PSK is selected as the authentication method.

- **User ID/Password**
You can specify settings only when LEAP, EAP-FAST, PEAP, EAP-TTLS or EAP-TLS is selected as the authentication method. In addition, with EAP-TLS, it is not necessary to register a password, but a client certificate must be registered. To register a certificate, connect to the Label Printer from a web browser, and then specify the certificate. For more information on using a web browser, see Web Based Management on page 129.

• **Display the key and password on-screen**
  If this check box is selected, keys and passwords are displayed in plain (non-encrypted) text.

### Communication Modes and Authentication Methods/Encryption Modes

- **When Communication Mode** is set to **Ad-hoc**

<table>
<thead>
<tr>
<th>Authentication Method</th>
<th>Encryption Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open System</td>
<td>None / WEP</td>
</tr>
</tbody>
</table>

- **When Communication Mode** is set to **Infrastructure**

<table>
<thead>
<tr>
<th>Authentication Method</th>
<th>Encryption Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open System</td>
<td>None / WEP</td>
</tr>
<tr>
<td>Shared Key</td>
<td>WEP</td>
</tr>
<tr>
<td>WPA/WPA2-PSK</td>
<td>TKIP+AES / AES</td>
</tr>
<tr>
<td>LEAP</td>
<td>CKIP</td>
</tr>
<tr>
<td>EAP-FAST/NONE</td>
<td>TKIP+AES / AES</td>
</tr>
<tr>
<td>EAP-FAST/MS-CHAPv2</td>
<td>TKIP+AES / AES</td>
</tr>
<tr>
<td>EAP-FAST/GTC</td>
<td>TKIP+AES / AES</td>
</tr>
<tr>
<td>PEAP/MS-CHAPv2</td>
<td>TKIP+AES / AES</td>
</tr>
<tr>
<td>PEAP/GTC</td>
<td>TKIP+AES / AES</td>
</tr>
<tr>
<td>EAP-TTLS/CHAP</td>
<td>TKIP+AES / AES</td>
</tr>
<tr>
<td>EAP-TTLS/MS-CHAP</td>
<td>TKIP+AES / AES</td>
</tr>
<tr>
<td>EAP-TTLS/MS-CHAPv2</td>
<td>TKIP+AES / AES</td>
</tr>
<tr>
<td>EAP-TLS</td>
<td>TKIP+AES / AES</td>
</tr>
</tbody>
</table>

**IMPORTANT**

To specify higher level security settings:

When performing certificate verification with EAP-FAST, PEAP, EAP-TTLS or EAP-TLS authentication methods, the certificate cannot be specified from the Printer Setting Tool. After the Label Printer is configured to connect to the network, specify the certificate by accessing the Label Printer from a web browser.

For more information on using a web browser, see Web Based Management on page 129.
Wireless Direct Tab

Wireless Direct Settings

- SSID/Network Key Generation
  Select AUTO or STATIC.

- SSID (Network Name)/Network Key
  Specifies the SSID (25 ASCII characters or fewer) and the network key (63 characters or fewer) you want to use in the Wireless Direct mode.

Note
The factory settings for the SSID and password are as follows:
SSID: "DIRECT-*****_QL-1110NWB" where "*****" is the last five digits of the product serial number.
The password: 111***** where ***** is the last five digits of the product serial number.

- Channel
  Specifies the channel to use for the Wireless Direct mode.
Bluetooth Tab

Bluetooth Settings

• Visible to Other Devices
  Allows the Label Printer to be “discovered” by other Bluetooth devices.

• Change PIN code
  If this check box is selected, you can change the PIN.

• PIN code
  Specifies the PIN that will be used when pairing with devices compliant with Bluetooth 2.0 or earlier.

• Display the PIN code on-screen
  If this check box is selected, your computer displays the PIN by default.

• Request Secure Simple Pairing (SSP) settings during pairing
  If this check box is selected, pairing can be performed using the Label Printer buttons for devices that are compliant with Bluetooth 2.1 or later.

Auto Reconnect

• Auto re-pairing
  Sets whether or not to automatically reconnect to a previously connected Apple device (iPad, iPhone or iPod touch).
Apply Setting Changes to Multiple Label Printers

1. After applying settings to the first Label Printer, disconnect the Label Printer from the computer, and then connect the second Label Printer to the computer.

2. Select the newly connected Label Printer from the Printer drop-down list.

   **Note**

   If the **Automatically detects the connected printer, and retrieves the current settings** check box in the **Option Setting** dialog box is selected, the Label Printer connected with the USB cable is automatically selected. For more information, see *Communication Settings for Windows®* on page 26.

3. Click **Apply**.
   The same settings that were applied to the first Label Printer are applied to the second Label Printer.

   **Note**

   We recommend selecting the **Automatically restart the printer after applying new settings** check box when configuring the first Label Printer so that you can confirm that a connection with the wireless access point/router can be correctly established with the settings. For more information, see *Communication Settings for Windows®* on page 26.

4. Repeat steps 1 – 3 for all Label Printers whose settings you want to change.

**IMPORTANT**

If the IP address is set to **STATIC**, the Label Printer's IP address will also be changed to the same address as the first Label Printer. Change the IP address if needed.

**Note**

To save the current settings in a file, click **File > Export**.

The same settings can be applied to another Label Printer by clicking **File > Import**, then selecting the exported settings file. For further information, see *Communication Settings for Windows®* on page 26.
Device Settings for Windows®

Use **Device Settings** in the Printer Setting Tool to specify or change printer settings when connecting the Label Printer and computer with a USB Cable or via a Bluetooth connection. Not only can you change the device settings for one Label Printer, but you can also apply the same settings to multiple Label Printers.

When printing from a computer application, various printing settings can be specified from the printer driver; however, by using **Device Settings** in the Printer Setting Tool, more advanced settings can be specified.

When you open **Device Settings**, the Label Printer's current settings are retrieved and displayed. If the current settings cannot be retrieved, the previous settings are displayed. If the current settings cannot be retrieved and previous settings were not specified, the machine’s factory settings appear.

**Settings Dialog Box**

![Device Settings dialog box diagram]

1. **Menu Bar**
   Commands are categorized under each menu (File, Maintenance, and About) by function.

2. **Printer**
   Specifies the Label Printer you want to configure.
3 Settings Tabs
Contains settings that may be specified or changed.

Note
If appears on a tab, the settings in that tab cannot be changed. In addition, the settings in the tab will not be applied to the Label Printer even if you click Apply. The settings in the tab will not be saved or exported when you use the Save in Command File or Export commands.

4 Current Settings
Retrieves the settings from the currently-connected Label Printer and displays them in the dialog box. Settings will also be retrieved for parameters on tabs with .

5 Disable these settings
When this check box is selected, appears on the tab, and the settings can no longer be specified or changed.

Settings in a tab where appears will not be applied to the Label Printer even if Apply is clicked. In addition, the settings in the tab will not be saved or exported when you use the Save in Command File or Export commands.

6 Parameters
Displays the current settings.

7 Exit
Exits Device Settings and returns to the main window of the Printer Setting Tool.

8 Apply
Applies the settings to the Label Printer.
To save the specified settings in a command file, select Save in Command File from the drop-down list. The saved command file can be used with the mass storage mode to apply the settings to a Label Printer. For more information, see Mass Storage Mode on page 70.
Menu Bar

File Menu Options

• **Apply Settings to the Printer**
  Applies the settings to the Label Printer.

• **Check Setting**
  Displays the current settings.

• **Save Settings in Command File**
  Saves the specified settings in a command file.

• **Import**
  Imports an exported file.

• **Export**
  Saves the current settings in a file.

Maintenance Menu Options

• **Print Unit Settings...**
  Prints a report containing the current firmware version and device setting information.
  You can also print this report using the Cutter (✓) Button. For more information, see Confirm Label Printer Settings on page 65.

**Note**

When you print this report, we recommend using a 2.4" (62 mm) or wider DK Roll.

• **Factory Reset**
  Resets all the settings to the factory settings, including device settings, transferred data, and network settings.

• **Reset only Device Settings**
  Resets the device settings in the Basic, Advanced, and Management tabs to the factory settings.

• **Delete Template and Database**
  Deletes the templates and databases stored in the Label Printer.

• **Option Settings**
  If the Do not display an error message if the current settings cannot be retrieved at startup check box is selected, a message is not displayed the next time.
Basic Tab

• **Auto Power On**
  Specifies whether the Label Printer turns on automatically when the AC Power Cord is plugged into an AC power outlet.

• **Auto Power Off**
  Specifies the period of time that passes before the Label Printer turns off automatically when connected to an AC power outlet.

**Note**
Auto Power Off is disabled when connecting with wireless network, wired network, or Bluetooth connection.

Advanced Tab

• **Print Data after Printing**
  Specifies whether or not print data is erased after printing.

• **Printer Information Report**
  Selects the information you want to include in the Label Printer Information Report.

• **Auto Cut**
  Sets the cutting method when printing multiple labels.

• **Serialize Mode**
  Specifies how you want to serialize (number) your printed labels.

Management Tab

**IMPORTANT**
To display this tab, you must have administrator privileges for the computer or the Label Printer. Check if you have administrator privileges for the Label Printer by clicking **Printer properties**, and then clicking the **Security** tab.

• **Command Mode**
  Selects the command mode type.

• **Airplane Mode**
  Allows disabling the Bluetooth or Wi-Fi interfaces. This function is useful when you use the Label Printer in a place where signal transmissions are not allowed.
Apply Setting Changes to Multiple Label Printers

1. After applying the settings to the first Label Printer, disconnect it from your computer, and then connect the second Label Printer.

2. Select the newly connected Label Printer from the Printer drop-down list.

3. Click Apply. The same settings that were applied to the first Label Printer are applied to the second Label Printer.

4. Repeat steps 1 – 3 for all Label Printers whose settings you want to change.

Note

To save the current settings in a file, click File > Export. The same settings can be applied to another Label Printer by clicking File > Import, and then selecting the exported settings file. For more information, see Device Settings for Windows® on page 36.
P-touch Template Settings for Windows®

P-touch Template mode allows you to insert data into text and barcode objects from a downloaded template using an optional Barcode Scanner (PA-BR-001) or other devices connected to the Label Printer. Please note the available options and supplies may vary depending on your country.

To specify or change P-touch Template functions, go to the Printer Setting Tool and select P-touch Template Settings.

Note

- P-touch Template mode is also compatible with other input devices like a scale, testing machine, controller, or a programmable logic device.
- For more information on P-touch Template Settings, download the P-touch Template Manual/Command Reference (English only) from the Brother Solutions Center at support.brother.com/manuals.
**P-touch Template Settings Dialog Box**

1. **Default Command Mode**
   Specifies the P-touch Template mode as the default mode. To change the mode, see the *Management Tab* on page 39.

2. **Default Template Number**
   Specifies a default template number that the Label Printer sets when it is turned on. If you do not want to transfer a template to the Label Printer, do not specify a template number.

3. **Data Delimiter for P-touch Template**
   Displays a symbol used to indicate the boundaries between groups of data in a file (maximum of 20 characters).

4. **Trigger for P-touch Template Printing**
   Specifies a trigger to begin printing from a number of options.
Change the Label Printer Settings

• **Command Character**: Printing starts when the command character specified here is received.

• **Data Insertion into All the Objects**: Printing starts when the delimiter for the last object is received.

• **Received Data Size**: Printing starts when the number of characters specified here is received. However, delimiters are not counted in the number of characters.

5 **Character Code Table**
   Selects one of the character code sets.

6 **International Character Set**
   Lists character sets for specific countries.
   The following codes vary depending on the selected country:
   23h 24h 40h 5Bh 5Ch 5Dh 5Eh 60h 7Bh 7Ch 7Dh 7Eh
   To change the characters, download the *P-touch Template Manual/Command Reference* (English only) from your model’s Manuals page on the Brother Solutions Center at support.brother.com/manusals.

7 **Command Prefix Character**
   Specifies the prefix character code that identifies commands used in P-touch Template mode.

8 **Non-Printed Character**
   Characters specified here are not printed when data is received (maximum of 20 characters).

9 **Available Return Code**
   The line feed code is used when feeding data to indicate that the following data should be moved to the next line in a text object. Select one of four line feed codes or type the line feed code you want (maximum of 20 characters).

10 **Replace FNC1**
    Replaces GS codes with FNC1.

11 **Number of Copies**
    Sets the number of copies (maximum of 99 copies).

12 **Cut option**
    Specifies if the Label Printer should cut the labels automatically and how many labels to print before cutting (maximum of 99 labels).

13 **Set**
    Applies the settings to the Label Printer.
    To save the specified settings to a command file to reuse in the future, select **Save in Command File** from the drop-down list. The saved command file can be used with the mass storage mode to apply the settings to a Label Printer. For more information, see *Mass Storage Mode* on page 70.

14 **Cancel**
    Cancels the settings and closes the dialog box. The settings remain unchanged.

15 **Default**
    Returns all setting values in P-touch Template Settings dialog box to the default values.
Change the Label Printer Settings

Printer Setting Tool for Mac

Using the Printer Setting Tool, you can specify the Label Printer's communication settings and device settings from a Mac. Not only can you change the device settings for one Label Printer, but you can also apply the same settings to multiple Label Printers.

Note

The Printer Setting Tool is automatically installed when you use the initial installer to install the printer driver. For more information, see Install Printer Drivers and Software on a Computer on page 9.

IMPORTANT

The Printer Setting Tool is available only with compatible Brother Label Printers.

Before Using the Printer Setting Tool

- Make sure the AC Power Cord is connected to the Label Printer and to an AC power outlet.
- Make sure the printer driver has been installed correctly and you can print.
- Connect the Label Printer to a computer with a USB Cable. Settings cannot be specified using Wi-Fi by using this tool.

Use the Printer Setting Tool for Mac

1. Connect the Label Printer you want to configure to the computer.
2. Click Macintosh HD > Applications > Brother > Printer Setting Tool > Printer Setting Tool.app. The Printer Setting Tool window appears.
3. Check that the Label Printer you want to configure appears next to Printer. If a different Label Printer appears, select the Label Printer you want from the pop-up list.
4. Select any of the Settings Tabs, and then specify or change the settings you want.
5. Click Apply Settings to the Printer to apply the settings to the Label Printer.
6. Click Exit.

IMPORTANT

Use the Printer Setting Tool to configure the Label Printer only when the Label Printer is idle. The Label Printer may malfunction if you try to configure it while it is processing or printing a print job.
Change the Label Printer Settings

Settings Dialog Box

1 Printer
Lists the connected Label Printers.

2 Import
Imports settings from a file.

3 Export
Saves the current settings in a file.

4 Settings Tabs
Contain settings that you can specify or change.

5 Apply Settings to the Printer
Applies the settings to the Label Printer.

6 Factory Reset
Resets all the settings to the factory settings, including device settings, transferred data, and network settings.

7 Reset only Device Settings...
Resets the device settings in the Basic, Advanced, and Management tabs to the factory settings.

8 Print Unit Settings
Prints a report containing firmware version and device setting information.
You can also print this report using the Cutter (✂) Button. For more information, see Confirm Label Printer Settings on page 65.

Note
When you print this report, we recommend you use a 2.4" (62 mm) or wider DK Roll.

9 Current Settings
Retrieves the settings from the currently connected Label Printer and displays them in the dialog box.

10 Exit
Exits the Printer Setting Tool.
Basic Tab

- **Auto Power On**
  Specifies whether the Label Printer turns on automatically when the AC Power Cord is plugged into an AC power outlet.

- **Auto Power Off**
  Specifies the period of time that passes before the Label Printer turns off automatically when connected to an AC power outlet.

**Note**
Auto Power Off is disabled when connecting with wireless network, wired network, or Bluetooth connection.

Advanced Tab

- **Print Data after Printing**
  Specifies whether or not print data is erased after printing.

- **Printer Information Report**
  Selects the information you want to include in the Label Printer Information Report.

- **Cut Settings**
  Sets the cutting method when printing multiple labels.

- **Serialize Mode**
  Specifies how you want to serialize (number) your printed labels.

Management Tab

- **Command Mode**
  Selects the command mode type.

- **Airplane Mode**
  Allows disabling the Bluetooth or Wi-Fi interfaces. This function is useful when you use the Label Printer in a place where signal transmissions are not allowed.
Bluetooth Settings Tab

- **Bluetooth Device Name**
  Displays the Bluetooth device name.

- **Bluetooth Address**
  Displays the acquired Bluetooth address.

- **Visible to Other Devices**
  Allows the Label Printer to be "discovered" by other Bluetooth devices.

- **Auto re-pairing**
  Sets whether or not to automatically reconnect to a previously connected Apple device (iPad, iPhone, or iPod touch).

- **Change PIN code**
  If **On** is selected, you can change the PIN code that are compliant with Bluetooth 2.0 or earlier.

- **Request Secure Simple Pairing (SSP) settings during pairing**
  If this check box is selected, pairing can be performed using the Label Printer buttons for devices that are compliant with Bluetooth 2.1 or later.

Wireless LAN Tab

- **Wireless Direct**
  Turns the Wireless Direct function on or off.

- **SSID/Network Key Generation**
  Selects **AUTO** or **STATIC**.

- **SSID (Network Name)/Network Key**
  Specifies the SSID (3 to 25 ASCII characters) and the network key you want to use in the Wireless Direct mode.
  You can specify a setting only when **STATIC** is selected as **SSID/Network Key Generation**.

- **Display current settings**
  Displays the current settings for Wireless Direct. Click **Current Settings** to update the displayed settings with the most recent information.
Apply Setting Changes to Multiple Label Printers

1. After applying settings to the first Label Printer, disconnect the Label Printer from the computer, and then connect the second Label Printer to the computer.

2. Select the newly connected Label Printer from the Printer drop-down list.

3. Click Apply Settings to the Printer. The same settings that were applied to the first Label Printer are applied to the second Label Printer.

4. Repeat steps 1 – 3 for all Label Printers whose settings you want to change.

**Note**

To save the current settings in a file, click Export. The same settings can be applied to another Label Printer by clicking Import, then selecting the exported settings file. For more information, see Settings Dialog Box on page 45.
Change the Label Printer Settings

Change Settings When Printing from a Mobile Device

When using a mobile device, change any necessary settings using the application before printing. The settings that can be changed vary by application.

Note

Before connecting a mobile device, you can specify detailed settings by connecting the Label Printer to a computer and using the Printer Setting Tool. For more information, see Change the Label Printer Settings on page 23.
Print Labels Using P-touch Template

P-touch Template Operations

P-touch Template mode allows you to insert data into text and barcode objects from a downloaded template using an optional Barcode Scanner (PA-BR-001) or other devices connected to the Label Printer.

Basic Operations

- **Standard Template Printing** (see page 54)
  
  Download frequently used templates or images and scan a barcode to select which one to print.

- **Advanced Template Printing** (see page 56)
  
  Download a template and scan a barcode to print a copy or to insert the scanned data into a different template.

- **Database Lookup Printing** (see page 59)
  
  Download a database linked to a template and scan a barcode to find a record to insert into the template and print it out.

Advanced Features

- **Numbered (Serialized Number) Printing** (see page 62)
  
  Automatically increment printed text or barcodes in any downloaded template.

**Note**

- P-touch Template mode is also compatible with other input devices like a scale, testing machine, controller, or a programmable logic device.
- See the *P-touch Template Manual/Command Reference* for more information. You can download the latest versions from the Brother Solutions Center at support.brother.com/manuals.
Preparation

Before connecting the Barcode Scanner to the Label Printer, specify the Barcode Scanner settings using the P-touch Template Settings (in the Printer Setting Tool).

Specify Settings in the P-touch Template Settings Tool

1. Connect the Label Printer and the computer via a USB Cable, and then turn on the Label Printer.
2. Start the Printer Setting Tool.
   - For Windows® 7 / Windows Server® 2008 / Windows Server® 2008 R2: Click Start > All Programs > Brother > Label & Mobile Printer > Printer Setting Tool.
   - For Windows® 10 / Windows Server® 2016: Click Start > Brother > Printer Setting Tool.
3. Click P-touch Template Settings.
4. Select the appropriate settings, and then click Set.
Note

- By default, printing begins when the code "^FF" is scanned from a barcode using a Barcode Scanner. (This can be changed with the settings highlighted by (A) in the previous image.)
  If Received Data Size is selected with the number of bytes setting, the template will automatically print after the specified number of bytes have been scanned.
- Because the print mode setting returns to raster mode each time you print from the computer, you must change the setting to template mode again.
- If you turn off the Label Printer and then turn it on again, the Label Printer starts up in template mode.
Connect a Barcode Scanner

We recommend using a reliable high-quality Barcode Scanner and checking the Barcode Scanner specifications before selecting a model.

■ Barcode Scanner connection methods:
  Use the USB Host interface, the Wi-Fi interface, or the Bluetooth interface.

■ Recommended Barcode Scanner selection criteria:
  • When using the USB host interface: HID-class models that can be identified as a keyboard (ex. optional: PA-BR-001)
  • When using the Bluetooth interface: Bluetooth Version 2.1 + EDR (Class 1) models that support SPP or OPP profiles

Note
• For P-touch Template mode, templates must first be downloaded from a computer to the Label Printer using P-touch Transfer Manager. For more information, see How to Use P-touch Transfer Manager and P-touch Library (Windows® only) on page 93.
• The barcode scanner should be programmed to use the English keyboard. For beginners, the barcode scanner should be programmed to scan data with no prefix or suffix characters. For advanced users, the prefix and suffix characters can be used as commands on the Label Printer to make a P-touch Template mode solution easier to use.
• Contact the manufacturer for more information on how to use and program a specific Barcode Scanner model.
Print Labels Using P-touch Template

Standard Template Printing

Download frequently-used templates or images and simply scan a barcode to select which one to print.

Example:

⚠️ DANGER

Note

- For more information on the barcodes that can be scanned using various settings, see List of Barcodes for the P-touch Template Function on page 161.
- Grouped objects will be converted and sent as an image.

1. Using P-touch Transfer Manager, transfer (from P-touch Editor) a template (label layout) to the Label Printer. For more information, see How to Use P-touch Transfer Manager and P-touch Library (Windows® only) on page 93.

Note

- A text object in the label layout can be converted to an image. After being converted to an image, the text cannot be changed. This is useful for protecting frequently-used templates from accidental edits.

   In the P-touch Editor Layout window, right-click the text object, and then click Properties. Click the Expanded tab, and then select the Text Cannot Be Edited check box.

   If the Expanded tab does not appear, click Tools > Options > General. In the Others section, select the Display Expanded Tabs of Object Properties check box.

   When the check box is cleared, the object is converted back to text that can be edited.

2. When you transfer data to Configurations in P-touch Transfer Manager, select the folder containing the data you want to transfer.

Note

- When a template is transferred to Configurations in P-touch Transfer Manager, the Key Assign number is automatically assigned.
  - For basic operations, you can specify a Key Assign number between 1 and 10.
  - For advanced operations, you can specify a Key Assign number between 1 and 255 for any downloaded templates into the Label Printer but you will need to scan different barcodes in step 6 to select and print it. For more information, download the P-touch Template Manual/Command Reference (English only) from the Brother Solutions Center at support.brother.com/manuals.

- You can add a custom folder under Configurations, and drag-and-drop a transferred template into that custom folder to manage different sets of templates.

3. Select the transferred template and then click Transfer to download the template to the Key Assign number in the Label Printer.

4. Scan the P-touch template command (Initialize + begin specifying settings) barcode. See List of Barcodes for the P-touch Template Function on page 161.
5. From the list of barcodes under Basic settings, scan each barcode to send a command or setting to the Label Printer.

**Note**

- Settings can be made with multiple commands.
- If no settings have been made by scanning the barcode commands, a template will be printed using the P-touch Template settings. The default P-touch Template settings are to print a single copy with Auto Cut turned On.

For more information on P-touch Template Settings, download *P-touch Template Manual/Command Reference* (English only) from the Brother Solutions Center at support.brother.com/manuals.

- To specify the number of copies you want, scan the Number of copies barcode, and then scan the barcodes under For entering numbers to specify a three-digit number.
  
  Example:
  
  Specify numbers by scanning the following barcodes: 7-i[0][0][7], 15-i[0][1][5]
  
  - To change the setting for the number of copies, scan the Number of copies barcode again, and then scan the barcodes for the new three-digit number.

6. Scan the barcode under Preset template number with the same number as the Key Assign number for the label layout you want.

7. The specified label is printed.
Advanced Template Printing

Download a template and scan a barcode to print a copy or insert the scanned data into a different template.

**Note**

- For more information on the barcodes that can be scanned using various settings, see *List of Barcodes for the P-touch Template Function* on page 161.
- If a barcode has a different protocol than the barcode template already registered with the Label Printer, you may be unable to create or print the barcode.
- Depending on the Barcode Scanner model, some barcode symbols and protocols may not be supported by this Label Printer.

1. Using P-touch Transfer Manager, transfer (from P-touch Editor) a template (label layout) to the Label Printer. For more information, see *How to Use P-touch Transfer Manager and P-touch Library (Windows® only)* on page 93.

```
CODE128/9-digit
```

**IMPORTANT**

It is important to design a template to meet the barcode symbology or protocol requirements, especially for the label size and barcode position in the label to fit the maximum number and type of characters being inserted from the barcode scanner. A barcode in the template cannot be created or scanned if the barcode with the inserted data does not fit entirely within the label printable image area.

2. When you transfer data to **Configurations** in P-touch Transfer Manager, select the folder containing the data you want to transfer.

**Note**

- When a template is transferred to **Configurations** in P-touch Transfer Manager, the **Key Assign** number is automatically assigned.
  - You can specify a **Key Assign** number between 1 and 10 for any downloaded templates into the Label Printer.
- You can add a custom folder under **Configurations**, and drag-and-drop a transferred template into that custom folder to manage different sets of templates.

3. Select the transferred template and then click **Transfer** to download the template to the **Key Assign** number in the Label Printer.
4. Scan the *P-touch template command (Initialize + begin specifying settings)* barcode. For more information, see *List of Barcodes for the P-touch Template Function* on page 161.

5. From the list of barcodes under *Basic settings*, scan each barcode to send a command or setting to the Label Printer.

**Note**

- Settings can be made with multiple commands.
- If no settings have been made by scanning the barcode commands, a template will be printed using the P-touch Template settings. The default P-touch Template settings are to print a single copy with *Auto Cut* turned *On*.

For more information on P-touch Template Setting Tool, download *P-touch Template Manual/Command Reference* (English only) from the Brother Solutions Center at support.brother.com/manuals.

- To specify the number of copies you want, scan the *Number of copies* barcode, and then scan the barcodes under *For entering numbers* to specify a three-digit number. The setting is automatically applied when three digits have been specified.

Example:

Specify numbers by scanning the following barcodes: 7-[0][0][7], 15-[0][1][5]

- To change the setting for the number of copies, scan the *Number of copies* barcode again, and then scan the barcodes for the new three-digit number.

6. Scan the *Select template* barcode and then scan the barcodes under *For entering numbers* with the same number (three digits) as the *Key Assign* number used for the downloaded template to be printed. The downloaded template will be automatically selected after the three digit numbers have been scanned.

Example:

Specify the three digit numbers by scanning the following barcodes: 7-[0][0][7], 15-[0][1][5]

**Note**

You can use P-touch Editor to create and print a label with a single barcode for step 6.

Example:

```
^TSS015
^TSS007
```
7 Scan a barcode that contains the data you want inserted into the barcode object in the selected downloaded template from step 6.

Example:

![Barcode Example](attachment://barcode1.png)

(CODE128/9-digit)

8 Scan the *Begin printing* barcode to send the command to start printing.

9 The barcode in the printed template will contain the data from the barcode scanned in step 7.

Example:

![Barcode Example](attachment://barcode2.png)
Database Lookup Printing

You can download a database linked to a template, scan a barcode as a keyword to find a record containing that keyword, and then insert that record into the template to print.

**Note**
- The Label Printer has reserved the leftmost column (A) of a downloaded linked database for this operation, therefore the keyword scanned from a barcode must be in this column of the database.
- For the Label Printer to find keywords successfully, the data in the leftmost column (A) must exactly match the keywords scanned from a barcode.
- P-touch Editor and the Label Printer can read only one line of data in each field of a linked database so we do not recommend using databases with two or more lines of data in the leftmost column (A).
- For more information on the barcodes that can be scanned using various settings, see *List of Barcodes for the P-touch Template Function* on page 161.

1. Use P-touch Editor to create a template and connect to a database file. You can link as many columns to a text and barcode objects in the template as needed.

**Note**
Make sure the keywords are included in the leftmost column (A) but do not link any text or barcode object in the template with field (A) if you do not need that data on the printed label.

For more information on specifying the settings, refer to the *P-touch Editor Help*.

2. Using P-touch Transfer Manager, transfer (from P-touch Editor) a template (label layout) to the Label Printer. For more information, see *How to Use P-touch Transfer Manager and P-touch Library (Windows® only)* on page 93. The linked database file will also be transferred.

3. When a template is transferred to **Configurations** in P-touch Transfer Manager, the **Key Assign** number is automatically assigned.

**Note**
You can add a custom folder under **Configurations**, and drag-and-drop a transferred template into that custom folder to manage different sets of templates.

4. Select the transferred template and then click **Transfer** to download the template to the **Key Assign** number in the Label Printer.
5. **Scan the P-touch template command barcode.**
   For more information, see *List of Barcodes for the P-touch Template Function* on page 161.

6. From the list of barcodes under *Basic settings*, scan each barcode to send a command or setting to the Label Printer.

**Note**

- Settings can be made with multiple commands.
- If you do not scan the barcode commands, a template is printed using the P-touch Template settings. The default P-touch Template settings are to print a single copy with **Auto Cut** turned **On**.
  
  For more information on P-touch Template Setting Tool, download *P-touch Template Manual/Command Reference* (English only) from the Brother Solutions Center at support.brother.com/manuals.

- To specify the number of copies you want to print, scan the *Number of copies* barcode, and then scan the barcodes under *For entering numbers* to specify a three-digit number. The setting is automatically applied when three digits have been specified.

  Example:
  
  Specify numbers by scanning the following barcodes: 7~0[0][7], 15~0[1][5]

  - To change the setting for the number of copies, scan the *Number of copies* barcode again, and then scan the barcodes for the new three-digit number.

7. **Scan the Select template barcode and then scan the barcodes under For entering numbers with the same number (three digits) as the Key Assign number used for the downloaded template to be printed.** The downloaded template is automatically selected after the three digit numbers have been scanned.

  Example:
  
  Specify the three digit numbers by scanning the following barcodes: 7~0[0][7], 15~0[1][5]
You can use P-touch Editor to create and print a label with a single barcode for step 6.

Example:

Scan a barcode that contains the keyword to look up in the downloaded database from step 4.

Example:

Scan the Delimiter barcode to send the command to start searching the downloaded database for the scanned keyword.

Scan the Begin printing barcode to send the command to start printing.

You can use P-touch Editor to create and print a label with a single barcode for steps 9 and 10.

Example:

The Label Printer will print the template with the data inserted from the database record, found with the scanned keyword.
Numbered (Serialized Number) Printing

You can automatically increase text numbers or barcodes up to 999 when printing downloaded templates. Select text and/or barcode objects to increment while printing.

Text Numbering (Serializing)

1. Use P-touch Editor to create or open a template and select a text object that you want to automatically increment while printing.
   Example:

   ![Example of a text object with numbers]

2. Highlight or drag the cursor over a group of numbers and letters within the text object that you want to increment (maximum of 15). The selected group is called the Numbering field.

   ![Example of highlighting numbers]

3. Right-click the Numbering field, and select Numbering.
Barcode Numbering (Serializing)

1. Use P-touch Editor to create or open a template and select a barcode object that you want to automatically increment while printing.

2. Right-click the barcode object, and select Properties. The Bar Code Properties window appears.

3. Highlight or drag the cursor over a group of numbers and letters within the barcode object that you want to increment (maximum of 15). The selected group is called the Numbering field.

4. Click Numbering, and then click OK.

Note

The Numbering button is enabled after a group of numbers and letters are highlighted.
Print with Numbering (Serializing) Advanced Operation

1. Using P-touch Transfer Manager, transfer (from P-touch Editor) a template (label layout) to the Label Printer. For more information, see *How to Use P-touch Transfer Manager and P-touch Library (Windows® only)* on page 93.

2. Set the Label Printer to print with Numbering (Serializing) advanced operation. See *List of Barcodes for the P-touch Template Function* on page 161.
   - Scan the *Number of serialized copies* barcode and then scan the barcodes under *For entering numbers* with the number of copies you want to print (three digits).
   
     Example:

     For five copies, specify the three digit numbers by scanning barcodes for [0][0][5]

**Note**

- Follow the P-touch Template mode basic operation procedures to start printing. For further information, see *Standard Template Printing* on page 54 to *Database Lookup Printing* on page 59.
- The Numbering field will increment by one number or letter with each label that is printed, and the count is permanently saved in the Label Printer.
- To reset a text or barcode object back to the original value, scan the *Initialize template data* barcode.
Confirm Label Printer Settings

You can print a Settings Report without connecting the Label Printer to a computer or mobile device.

1. Turn on the Label Printer.
2. Load 2.4” (62 mm) or wider DK Roll into the Label Printer. Press and hold the Cutter (✓) Button for two seconds. The report starts printing.

Crop Print (Print Barcode Labels) (Windows® only)

This Label Printer can print one or multiple barcodes from a Letter or A4 size .pdf file. It will automatically identify and then individually crop and print the barcodes you specify.

Note

- The Crop Print function is available only when printing from the Windows printer driver, and cannot be executed using P-touch Editor.
- Use Adobe Acrobat Reader XI/DC or greater to print a .pdf file.
Barcodes Compatible with Crop Print

- Code 39/ Code 3 of 9
- ITF/ ITF-14/ Interleaved 2 of 5
- GS1-128 (UCC/ EAN-128)
- Codabar (Code 2 of 7, NW-7)
- UPC-A
- UPC-E
- JAN-8/ EAN-8
- JAN-13/ EAN-13

Barcode Specification

<table>
<thead>
<tr>
<th>Property</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical width</td>
<td>0.2&quot; (5 mm) (minimum)</td>
</tr>
<tr>
<td>Horizontal width</td>
<td>The narrowest bar: 0.02&quot; (0.5 mm) (minimum)</td>
</tr>
<tr>
<td>Margin</td>
<td>10 times the narrowest bar width (minimum)</td>
</tr>
<tr>
<td>Color</td>
<td>Black</td>
</tr>
<tr>
<td>Background color</td>
<td>White</td>
</tr>
<tr>
<td>Cell width (widest bar)</td>
<td>0.02&quot; (0.5 mm) (minimum)</td>
</tr>
</tbody>
</table>

Create a Barcode Document to Use with Crop Print

To use the Crop Print function, create a barcode document and save it in .pdf format. Make sure the final barcode .pdf meets the following requirements:

Barcode Conditions

<table>
<thead>
<tr>
<th>Item</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total barcode amount</td>
<td>Between 1-99 barcodes</td>
</tr>
<tr>
<td>Barcode type</td>
<td>Use only barcodes that are compatible with the Crop Print feature. For more information, see Barcodes Compatible with Crop Print on page 66.</td>
</tr>
<tr>
<td>Barcode position</td>
<td>Make sure barcodes are not tilted or on an angle. They must be parallel with the top and bottom of each page. Make sure barcodes start at the top left corner of the page and run from top to bottom, continuing in columns from left to right.</td>
</tr>
</tbody>
</table>
Barcodes start in top left corner and run down the column, continuing at the top of the next column to the right.

<table>
<thead>
<tr>
<th>Correct Barcode Layout</th>
<th>Incorrect Barcode Layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barcodes start in top left corner and run down the column, continuing at the top of the next column to the right.</td>
<td>Not identified (not aligned along the top margin)</td>
</tr>
</tbody>
</table>

**Print Barcode Labels Using Crop Print**

**Note**
Make sure that your Label Printer is connected to a computer or mobile device via a USB Cable or network connection.

1. Open the barcode document .pdf file you want to print.
2. Click **File > Print**.
3. Click the **Printer** drop-down list, and then select your Label Printer.
4. In the **Page Sizing & Handling** section, select the **Actual Size** radio button.
5. Under **Orientation**, select the **Portrait** radio button.
6. Click **Properties**.
7 Click the **Basic** tab, and do one of the following:
- For Die Cut labels, clear the **Cut Every** check box.
- For Continuous Rolls, select the **Cut Every** check box.

8 Click the **Crop Print** tab, and select the **Automatically print individual labels with barcodes** check box.
Click the **Label/Paper Size** drop-down list, and then select your **Label/Paper Size**.

9 Click **OK**.

**Note**
Please select the closest DK label size to match the original size of the crop data. We recommend testing a sample before printing a large number of labels.

10 Print from the application’s print screen.
IMPORTANT

• Do not enlarge or reduce the size of the barcode sheet. The barcodes may not be identified correctly.

• When printing from Acrobat Reader, do the following:
  - In the Page Sizing & Handling section, deselect the Choose paper source by PDF page size radio button.
  - Under Orientation, select the Portrait radio button.
Mass Storage Mode

Description

The mass storage feature allows you to send a file to the Label Printer using the USB interface, without installing a printer driver.

This feature is useful for:

- Applying printer settings saved in a command file (.bin file format) or adding templates (.blf file format) into the Label Printer distributed by the administrator without using any software tools.
- Executing commands without installing the printer driver.
- Using a device with an Operating System (including non-Windows® operating systems) that has a USB host feature to print and transmit data.
Use the Mass Storage Mode

1. Confirm that the Label Printer is turned off.
2. Press and hold the Wi-Fi (WiFi) Button and the Power (Power) Button at the same time for several seconds. The Label Printer starts up in mass storage mode, the Status LED lights in green.
3. Connect the computer or device to the Label Printer via USB. The Label Printer's mass storage area appears as a folder on the computer or device's screen.

Note
If the mass storage area does not appear automatically, refer to the operating instructions for the computer or device’s operating system for information about accessing the mass storage area.

4. Drag and drop the file you want to copy to the mass storage area.
5. Press the WPS Button. The commands in the command file are executed, and the Status LED flashes once. When finished, the Status LED lights in green.
6. To turn mass storage mode off, turn off the Label Printer.

IMPORTANT
• When the Label Printer is turned off, mass storage mode is deactivated and any files in the mass storage area are deleted.
• This feature supports .bin, and .blf files. Other file formats are not supported.
• Do not create folders in the mass storage area. If a folder is created, files in the folder cannot be accessed.
• The capacity of the mass storage area is 2.5 MB. Files larger than 2 MB may not work correctly.
• If multiple files are copied, the order that the commands will be executed cannot be guaranteed.
• Wired LAN, Bluetooth and Wi-Fi are not available while the Label Printer is running in mass storage mode.
• Do not access other files in the mass storage area when executing a copied file.

Note
For more information on how to create a .blf file, see Create Transfer Files and Transfer Package Files on page 103.
JPEG Printing

Image data (JPEG) can be printed without using the printer driver.

Note

- JPEG images can be printed using the mass storage feature.
- The Object Push Profile (OPP) is used for printing via a Bluetooth connection.
- The Label Printer converts a color JPEG image to a ‘Black & White’ image using a dithering process.
- When sending a JPEG image that is already ‘Black & White’ the dithering process may produce a fuzzy image.
- To improve the image quality, try to turn off any preprocessing of the JPEG image.

- Only JPEG images can be printed. (Limited to files with the .jpg extension.)
- The maximum file size is 5 MB.
  (2 MB when the mass storage feature is used.)
- The maximum resolution is as follows:
  Height × Width = 12000 × 1296 dots
  If these limits are exceeded, the data received by the Label Printer is discarded and not printed.
- Print is at 1 pixel = 1 dot.
- The Label Printer performs binary processing (simple binary) to print the image.
- The image is printed with the height-to-width proportions of the received data.
Distributed Printing (Windows® only)

When printing a large number of labels, printing can be distributed among multiple Label Printers, via USB or network connection, to reduce printing time.

**Note**

The number of pages is divided among the selected Label Printers. If the specified number of pages cannot be evenly divided among the Label Printers, it will be divided in the order of the Label Printers as shown.

1. In P-touch Editor, click **File > Print**.
2. Click **Properties…**.
3. Click the **Advanced** tab, select the **Distributed Printing** check box, and then click **Settings**.

![Distributed Printing Diagram]
4 In the **Distributed Printing Settings** dialog box, select the Label Printers you want to use for distributed printing.

1 Click **Detect Current Paper Information…**
   The current Label Printer information detected appears below **Current Paper** and **Paper Type**.

2 Select the check box next to the **Printer Name** you want.

**Note**

- If the selected label width is different from that displayed in the **Current Paper** column, the icon appears. Load the Label Printer with the label width specified in **Set Width**.
- If multiple Label Printers are connected, you can find the Label Printer you want using its port name. The xxxxxxxxxx in BRNxxxxxxxxxxxx in the port name indicates the MAC address/Ethernet address of the Label Printer. The MAC address/Ethernet address can be checked by printing the Label Printer set-up information. For more information, see **Confirm Label Printer Settings** on page 65.
5 Specify the label size.
   ■ If only one Label Printer has been selected.
   
   In the Distributed Printing Settings dialog box from step 4, select the Label Printer whose settings you want to specify, and then either double-click or right-click, and then click Settings. From the Set Width drop-down list, select the label size.

   Note
   Information displayed in the Distributed Printing Settings dialog box from step 4 can be entered in the Notes text box.

   ■ If multiple Label Printers have been selected.
   
   In the Distributed Printing Settings dialog box from step 4, select the Label Printers whose settings you want to specify, right-click them, and then click Settings. From the Set Width drop-down list, select the label size. The same label size setting is applied to all selected Label Printers.

   Note
   The settings below Printer Settings and Notes are not available.

6 Click OK to close the label size setting window.

7 Click OK to close the Distributed Printing Settings window.
   Setup is completed.

8 Click OK to close the Properties window.

9 Start printing.

   Note
   • It may not be possible to detect information for a Label Printer connected via a USB hub or print server. Before printing, enter the settings manually, and check if the Label Printer can be used for printing.
   • Depending on whether a router is used and the security features in use, such as a firewall, it may not be possible to use this function.
   • We recommend performing a connection test for your operating environment. Contact your information technology manager or administrator for assistance.
## Application

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to Use P-touch Editor</td>
<td>77</td>
</tr>
<tr>
<td>How to Use the P-touch Address Book (Windows® only)</td>
<td>83</td>
</tr>
<tr>
<td>How to Use P-touch Editor Lite LAN (Windows® only)</td>
<td>88</td>
</tr>
<tr>
<td>How to Use P-touch Transfer Manager and P-touch Library (Windows® only)</td>
<td>93</td>
</tr>
<tr>
<td>How to Transfer Templates with P-touch Transfer Express (Windows® only)</td>
<td>110</td>
</tr>
<tr>
<td>How to Update P-touch Software</td>
<td>118</td>
</tr>
</tbody>
</table>
To use your Label Printer with your computer, install P-touch Editor and the printer driver. For the latest drivers and software, visit support.brother.com and go to your model's Downloads page.

For Windows®

Starting P-touch Editor

1. Start the P-touch Editor.

   - **For Windows® 7 / Windows Server® 2008 / Windows Server® 2008 R2:**
     Click Start > All Programs > Brother P-touch > P-touch Editor 5.2, or double-click the P-touch Editor 5.2 shortcut icon on the desktop.

   - **For Windows® 8 / Windows® 8.1 / Windows Server® 2012 / Windows Server® 2012 R2:**
     Click P-touch Editor 5.2 on the Apps screen or double-click the P-touch Editor 5.2 icon on the desktop.

   - **For Windows® 10 / Windows Server® 2016:**
     Click Start > P-touch Editor 5.2 under Brother P-touch, or double-click the P-touch Editor 5.2 icon on the desktop.

2. When P-touch Editor starts, select whether you want to create a new layout or open an existing layout.

   **Note**
   To change how P-touch Editor functions when it starts, click Tools > Options in the P-touch Editor menu bar to display the Options dialog box. On the left side, select the General heading, and then the setting you want in the Operations list box under Startup Settings. The factory setting is Display New View.
3 Select one of the displayed options:

1 To create a new layout, double-click **New Layout**, or click **New Layout** and then click →.
2 To create a new layout using a preset layout, double-click a category button, or select a category button and then click →.
3 To connect a preset layout to a database, select the check box next to **Connect Database**.
4 To open an existing layout, click **Open**.
Printing with P-touch Editor

- **Express mode**
  This mode allows you to quickly create layouts that include text and images.

Configure the Printing Settings in the Print screen before printing.
To print, click **File > Print** from the menu bar or click the Print icon.

- **Professional mode**
  This mode allows you to create layouts using a wide-range of advanced tools and options.

Configure the Printing Settings in the Print screen before printing.
To print, click **File > Print** from the menu bar or click the Print icon (A).
In addition, click the Print icon (B) to start printing without changing the printing settings.
Snap mode
This mode allows you to capture all or a portion of your computer screen display, print it as an image, and save it for future use.

1. Click the Snap mode selection button. The Description of Snap mode dialog box appears.

2. Click OK. The Snap mode palette appears.

Transfer Data to the Label Printer
To transfer data to the Label Printer, you must use P-touch Transfer Manager. For more information, see P-touch Transfer Manager on page 93.
For Mac

Start P-touch Editor

Double-click **Macintosh HD > Applications**, and then double-click the **P-touch Editor** application icon.

**Note**

When using a Mac, you cannot transfer label data created using P-touch Editor to the Label Printer.

When P-touch Editor starts, select whether you want to create a new layout or open an existing layout.
Operation modes

- **Standard mode**
  
  This mode allows you to create labels with text and images. The Standard mode consists of the following sections:

1. **Toolbar**
2. **Label Inspector**
3. **Database Connection Area**
4. **Object Inspector**
5. **Layout Window**

**Transfer Data to the Label Printer**

To transfer data to the Label Printer, you must use a Windows® computer. For more information, see *P-touch Transfer Manager* on page 93.
This section describes how to efficiently create labels from contacts using the P-touch Address Book. The screens may differ depending on your operating system.

(P-touch Address Book is not supported in some languages.)

Start the P-touch Address Book

1. Start the P-touch Address Book.
   - For Windows® 7 / Windows Server® 2008 / Windows Server® 2008 R2:
     Click Start > All Programs > Brother P-touch > P-touch Address Book 1.3, or double-click the P-touch Address Book 1.3 shortcut icon on the desktop.
   - For Windows® 8/ Windows® 8.1 / Windows Server® 2012 / Windows Server® 2012 R2:
     Click P-touch Address Book 1.3 on the Apps screen or double-click the P-touch Address Book 1.3 icon on the desktop.
   - For Windows® 10 / Windows Server® 2016:
     Click Start > P-touch Address Book 1.3 under Brother P-touch, or double-click the P-touch Address Book 1.3 icon on the desktop.

2. When the P-touch Address Book is launched, the Startup dialog box appears, which allows you to create new contacts, or import Outlook contacts and CSV formatted data.
In the **Startup** dialog box, specify the P-touch Address Book operation you want to perform and click the **OK** button.

- When **Create a New Contact** is selected, the Layout Window appears.
- When **Import Contacts from a CSV File** or **Import Contacts from Outlook** is selected, you can import contacts in other formats.
- Click the **Open Help**... button to open the P-touch Address Book Help files. The P-touch Address Book Help offers detailed information on available features and explains how to use the P-touch Address Book.
Layout Window

The Layout Window consists of the following sections:

1. **Menu Bar**
   Commands are categorized under each menu (File, Edit, View, Layout, and Tools) according to their functions.

2. **Standard Toolbar**
   Provides a group of frequently used commands (such as New Contact, Edit Contact, Find or Print).

3. **Text Toolbar**
   Used to adjust text attributes such as font size and alignment for text formatting.

4. **Layout Style Selection View**
   Displays layout styles stored in the folder.

5. **Layout Work Area**
   Used to display or edit a layout that uses the layout style in the Layout Style Selection view.

6. **Contact List Combo Box**
   Displays the contact list that is currently specified. You can choose from **Personal**, **Business**, **Other1**, **Other2**, and **Other3**.

7. **Index Tab**
   You can search within the field in Record View. Click **Tools > Sort** to open the **Sort** dialog box, and specify the field you want using **Key1**.

8. **Record View**
   Displays the contact data in each field. The data can also be edited (added, deleted, or modified).
Create a New Contact

This section explains how to create a new contact.

1. Click **File > New Contact**, or click the **New Contact** button.

   The **New Contact** dialog box appears.

2. Enter the new contact information.
1 New Contact Form Toolbar

The following commands are categorized in the menu:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Previous</td>
<td>Displays the previous contact.</td>
</tr>
<tr>
<td></td>
<td>Next</td>
<td>Displays the next contact.</td>
</tr>
<tr>
<td></td>
<td>New Contact</td>
<td>Displays the form window for a new contact.</td>
</tr>
<tr>
<td></td>
<td>Delete Contact</td>
<td>Deletes the contact that is currently selected.</td>
</tr>
</tbody>
</table>
|      | Image              | Allows you to insert an image for a contact from a file or a camera currently connected to the computer. The following file types are supported:  
• Bitmap (*.bmp, *.dib)  
• JPEG file (*.jpg, *.jpeg)  
• TIFF file (uncompressed) (*.tif)  
• GIF file (*.gif)  
• Icon (*.ico)  
• Windows Meta File (*.wmf, *.emf) (Image adjustment is not allowed.)  
• PNG file (*.png) |
|      | Save and Close     | Saves the contact and closes the New Contact dialog box.     |

2 Contact Form

Used to enter each item, such as name, address, phone number, company information, and email address for the new contact.

3 When you finish entering the data, click the Save and Close button to store.
How to Use P-touch Editor Lite LAN
(Windows® only)

With P-touch Editor Lite LAN you can quickly create various label layouts.
P-touch Editor Lite LAN is supported only when the machine is connected to a Network.

By downloading the installer from install.brother and installing it, the P-touch Editor Lite LAN program package is created on the desktop. Open the program package and copy it to a shared folder on the server. P-touch Editor Lite LAN on the server can be accessed by other network users to create labels, and print from a QL-1110NWB connected to the network.

How to share P-touch Editor Lite LAN:

1. Copy the folder containing P-touch Editor Lite LAN from your computer to a shared folder on the network.
2. Start up P-touch Editor Lite LAN from the shared folder on the network.
3. Double-click the \PteLiteLAN in the PteLiteLAN folder.
   P-touch Editor Lite LAN starts.
**Layout window**

1 **Command Toolbar**
2 **Properties Toolbar**
3 **Label View**

### 1 Command Toolbar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Displays the new label creation screen.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Opens a saved file with P-touch Editor Lite LAN.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Saves the data to your computer, but not to the Label Printer.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Inserts a new text box (convenient when creating labels containing both single and multiple lines of text).</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Inserts an image into your label. <strong>From file:</strong> Inserts an image stored on your computer. <strong>Screen capture:</strong> Inserts the selected area of the computer screen as a graphic. <strong>Symbol:</strong> Inserts one of your computer's built-in symbols.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Inserts a frame.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Displays the menu. The menu includes all P-touch Editor Lite LAN functionality.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Minimizes P-touch Editor Lite LAN.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Exits P-touch Editor Lite LAN.</td>
</tr>
</tbody>
</table>
2 Properties Toolbar

<table>
<thead>
<tr>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arial</td>
</tr>
<tr>
<td>24</td>
</tr>
<tr>
<td>B</td>
</tr>
<tr>
<td>1.06 &quot; (Auto)</td>
</tr>
<tr>
<td>A</td>
</tr>
<tr>
<td>Print Options...</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click to change the font.</td>
<td></td>
</tr>
<tr>
<td>Click to specify the font size. You can adjust the font size up or down one level by clicking А or А.</td>
<td></td>
</tr>
<tr>
<td>Specifies the font style: / Bold / Italic / Underline</td>
<td></td>
</tr>
<tr>
<td>Specifies the alignment of text in a text box.</td>
<td></td>
</tr>
<tr>
<td>Sets the width of the label. Click to automatically detect the width of the inserted label.</td>
<td></td>
</tr>
<tr>
<td>Sets the length of the label. Click to automatically adjust the length of the label to accommodate the entered text.</td>
<td></td>
</tr>
<tr>
<td>Changes the label direction to vertical.</td>
<td></td>
</tr>
<tr>
<td>Click to set the zoom factor for the Label View. You can also change the zoom factor by clicking or .</td>
<td></td>
</tr>
<tr>
<td>Click to print normally or to print with options. Print Options...: Auto Cut, Cut at end, Copies Auto Cut: Each label is automatically cut after printing. Cut at end: Cuts labels after the last label is printed. Copies: Prints multiple copies of a label. Printer Setup...: Displays a list of the connected Label Printers.</td>
<td></td>
</tr>
</tbody>
</table>

Note

- If multiple Label Printers are connected to the network, select the Label Printer to print with. A list of the Label Printers connected to the network can be displayed by clicking and then clicking Printer Setup.... You can find the Label Printer you want in the list from its IP address.

- The IP address of Label Printers can be checked by printing the Label Printer set-up information. Press and hold the Cutter (膦) Button when the power is on to print the Label Printer set-up information.

- We recommend that you set the Label Printer location using BRAdmin because it enables you to view the Label Printer in the list.
## 3 Label View

<table>
<thead>
<tr>
<th>Display</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Label View" /></td>
<td>This label view is displayed when the software is started. The width of label currently set is displayed on the left of label image. When &quot;Auto&quot; is shown on the right, the length of label is automatically adjusted to the length of text.</td>
</tr>
<tr>
<td><img src="image" alt="Manually Change Label" /></td>
<td>To manually change the length and width of the label, move the pointer to the label area's border, and then drag it when the blue line appears.</td>
</tr>
<tr>
<td><img src="image" alt="Adjust Window" /></td>
<td>To adjust the size of the P-touch Editor Lite LAN window, move the pointer over an edge of the window and drag it when the pointer changes to an arrow.</td>
</tr>
<tr>
<td><img src="image" alt="Guidelines" /></td>
<td>Guidelines are sometimes displayed when moving objects. They are shown when the object is aligned at the left, right, top, or bottom edge of the Printable area, or in the center. In the illustration on the left, the guidelines indicate that the object is centered at the top edge of the label.</td>
</tr>
<tr>
<td><img src="image" alt="Insert Text" /></td>
<td>Inserted text boxes, images, and frames are treated as objects. Objects are surrounded by handles (indicated by eight blue points).</td>
</tr>
<tr>
<td><img src="image" alt="Selected Object" /></td>
<td>Indicates that an object is selected.</td>
</tr>
<tr>
<td><img src="image" alt="Object Handle" /></td>
<td>The pointer changes to an arrow when moved over a handle. Drag the handles to change the object's size.</td>
</tr>
<tr>
<td><img src="image" alt="Object Move" /></td>
<td>To move objects, drag them when the pointer changes to a crosshair. For text objects, the pointer only changes to a crosshair over the border of the object.</td>
</tr>
</tbody>
</table>
Right-click in the layout view area to select and execute the following menu items.

**Other Functions (right-click to view)**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Click <strong>Undo</strong> to undo the last operation. Click <strong>Redo</strong> to redo the last operation.</td>
</tr>
<tr>
<td>Redo</td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td>Select the text area (or object) that you want to cut or copy and select <strong>Cut</strong> or <strong>Copy</strong>. Click in the destination area and select <strong>Paste</strong>.</td>
</tr>
<tr>
<td>Copy</td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td></td>
</tr>
<tr>
<td>Margins</td>
<td>The function is not available for this model.</td>
</tr>
<tr>
<td>Insert</td>
<td>Click <strong>Insert</strong>. Select <strong>Text box</strong> to insert text into the label. Select <strong>From File</strong> to insert an image stored on your computer. Select <strong>Screen Capture</strong> to insert the selected area of the computer screen. Select <strong>Symbol</strong> to insert one of your computer's built-in symbols. Select <strong>Frame</strong> to insert one of P-touch Editor Lite LAN built-in frames.</td>
</tr>
<tr>
<td>Direction</td>
<td></td>
</tr>
<tr>
<td>Numbering</td>
<td>Select the number or letter within your text and click <strong>Numbering</strong> to insert an incremented number or letter on each label. Click ➡️ to the right of the <strong>Print</strong> button and click <strong>Print Options</strong>. Check the <strong>Numbering</strong> box and enter the number of labels for printing in the <strong>Count</strong> field. Click the <strong>Print</strong> button.</td>
</tr>
<tr>
<td>Change Image</td>
<td>Select the image and click <strong>Change Image</strong> to replace the current image with a different image.</td>
</tr>
<tr>
<td>Rotate</td>
<td>Rotate objects to 0°, 90°, 180°, or 270°.</td>
</tr>
<tr>
<td>Order</td>
<td>Select one of the objects and click <strong>Order</strong>, then select <strong>Bring to Front</strong>, <strong>Send to Back</strong>, <strong>Bring Forward</strong>, or <strong>Send Backward</strong> to set the order of each object in the layer.</td>
</tr>
<tr>
<td>Options</td>
<td>Click <strong>Options</strong>. Select either <strong>mm (millimeters)</strong> or <strong>inches (in)</strong> to set the measurement unit setting. Select P-touch Editor Lite LAN language. Restart the application to apply the new selected &quot;Language&quot;. Select either <strong>Display New Value after Printing</strong> or <strong>Reset to Original Value after Printing</strong> to set the numbering option.</td>
</tr>
<tr>
<td>Brother Solutions Center</td>
<td>Click <strong>Brother Solutions Center</strong> to go to the website for assistance and information.</td>
</tr>
<tr>
<td>About</td>
<td>Click <strong>About</strong> to learn about the P-touch Editor Lite LAN version.</td>
</tr>
<tr>
<td>Exit</td>
<td>Click <strong>Exit</strong> to exit P-touch Editor Lite LAN.</td>
</tr>
</tbody>
</table>
P-touch Transfer Manager

This program allows you to transfer templates and other data to the Label Printer and save backups of your data on the computer.

First P-touch Transfer Manager transfers data to the Label Printer, and then P-touch Template sends text data that will be inserted into the template and printed. For more information on P-touch Template, download the *P-touch Template Manual/Command Reference* (English only) from the Brother Solutions Center at support.brother.com/manuals.

The transfer function is needed to use P-touch Template.

The template can also be transferred via the network.

Transfer the Template to P-touch Transfer Manager

To use P-touch Transfer Manager, you must first transfer templates created in P-touch Editor to P-touch Transfer Manager.

1. In P-touch Editor, open the template you want.
2. Click File > Transfer Template > Transfer.

When P-touch Transfer Manager starts, the Main window appears.

**Note**

The following method can also be used to start the P-touch Transfer Manager:

- **For Windows® 7 / Windows Server® 2008 / Windows Server® 2008 R2:**
  Click Start > All Programs > Brother P-touch > P-touch Tools > P-touch Transfer Manager 2.3.

- **For Windows® 8 / Windows® 8.1 / Windows Server® 2012 / Windows Server® 2012 R2:**
  Click P-touch Transfer Manager 2.3 on the Apps screen.

- **For Windows® 10 / Windows Server® 2016:**
  Click Start > P-touch Transfer Manager 2.3 under Brother P-touch.
Main window

1 Menu Bar
Provides access to various commands, which are grouped under each menu title (File, Edit, View, Tool, and Help) according to their functions.

2 Toolbar
Provides access to frequently used commands.

3 Printer Selector
Allows you to select which Label Printer the data will be transferred to. When you select a Label Printer, only the data that can be sent to the selected Label Printer appears in the data list.

4 Folder List
Displays a list of folders and Label Printers. When you select a folder, the templates in the selected folder appear in the template list.
If you select a Label Printer, the current templates and other data stored in the Label Printer appear.

5 Template List
Displays a list of templates in the selected folder.

6 Preview
Displays a preview of the templates in the templates list.
### Explanations of the Toolbar Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Button name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Transfer Icon" /></td>
<td><strong>Transfer</strong></td>
<td>Transfers templates and other data from the computer to the Label Printer.</td>
</tr>
<tr>
<td><img src="image" alt="Save Transfer File Icon" /></td>
<td><strong>Save Transfer File</strong>&lt;br&gt;(When not connected to a Label Printer)</td>
<td>Changes the file type of the data to be transferred to other applications. Select <strong>BLF</strong> for the filename extension when printing labels using Mass Storage Mode (USB), or when transferring the data using BRAdmin Professional (LAN or Wi-Fi) or Mobile Transfer Express (Wi-Fi). Select <strong>PDZ</strong> when transferring the data using Transfer Express (USB). The available interfaces differ depending on your model.</td>
</tr>
<tr>
<td><img src="image" alt="Backup Icon" /></td>
<td><strong>Backup</strong></td>
<td>Retrieves the templates and other data saved in the Label Printer and saves it on the computer.</td>
</tr>
<tr>
<td><img src="image" alt="Open Icon" /></td>
<td><strong>Open</strong></td>
<td>Opens the selected template.</td>
</tr>
<tr>
<td><img src="image" alt="Search Icon" /></td>
<td><strong>Search</strong></td>
<td>Allows you to search for templates or other data registered to P-touch Library.</td>
</tr>
<tr>
<td><img src="image" alt="Display Style Icon" /></td>
<td><strong>Display Style</strong></td>
<td>Changes the file display style.</td>
</tr>
</tbody>
</table>
Transfer Templates or Other Data from the Computer to the Label Printer

Use the following procedure to transfer templates, databases, and images from the computer to the Label Printer.

1. Connect the computer and the Label Printer via USB and turn on the Label Printer. The Label Printer model name appears next to a printer icon in the folder view. If you select the Label Printer in the folder view, the current templates and other data stored in the Label Printer appear.

Note

- If a Label Printer is disconnected or offline, it does not appear in the folder view.
- Before transferring data, check that the computer and the Label Printer are correctly connected via a USB Cable or a wireless connection, and that the Label Printer is On.

2. Select the Label Printer that you want to transfer the template or other data to.
3. Right-click the **Configurations** folder, select **New**, and then create a new folder.

4. Drag the template or other data that you want to transfer and place it in the new folder.

**Transfer Function Specification**

<table>
<thead>
<tr>
<th>Data type</th>
<th>Maximum number of transferable items</th>
<th>Restriction details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template</td>
<td>255</td>
<td>Each template can contain a maximum of 50 objects.</td>
</tr>
<tr>
<td>Database</td>
<td>99</td>
<td>- Only *.csv files can be transferred.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Each *.csv file can contain a maximum of 65000 records.</td>
</tr>
<tr>
<td>Image (transferred symbols)</td>
<td>99</td>
<td>- Only *.bmp files can be transferred.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Monochrome *.bmp files are recommended.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The size limit is 1296 × 1296 pixels.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Wide images may be cropped.</td>
</tr>
</tbody>
</table>
**Note**

You can confirm the available space in the transfer file memory by printing the Printer Setting Report. For more information, see *Confirm Label Printer Settings* on page 65.

See **RomFree** in the report for the available space ¹.

¹ The available space that appears in "RomFree = ******** byte" may be different from the actual available space.

You can view the templates and other data by selecting:

- The folder in the **Configurations** folder
- **All Contents**
- One of the categories under **Filter**, such as **Layouts**

When transferring multiple templates or other data, drag all files you want to transfer and place them in the new folder.

Each file is assigned a key number (memory location in the Label Printer) when it is placed in the new folder.
To change the key number assigned to an item, right-click the item, select **Key Assign**, and then select the key number you want.

**Note**

- Except for the data in databases, all data transferred to the Label Printer is assigned a key number.
- If the template or other data transferred to the Label Printer has the same key number as another template already saved in the Label Printer, the new template will overwrite the old one. You can confirm the templates key number assignments saved in the Label Printer by backing up the templates or other data. For more information, see *Back up Templates or Other Data Saved in the Label Printer* on page 101.
- If the Label Printer memory is full, remove one or more templates from the Label Printer’s memory. For more information, see *Back up Templates or Other Data Saved in the Label Printer* on page 101.

To change the template names or other data that you want to transfer, click the item you want, and then type the new name. The number of characters used for the template names may be limited depending on the Label Printer model.
Select the folder containing the templates or other data that you want to transfer, and then click **Transfer**. A confirmation message appears.

**Note**

- You can also transfer individual items to the Label Printer without adding them to a folder. Select the template or other data that you want to transfer, and then click **Transfer**.
- Multiple items and folders can be selected and transferred in one operation.

Click **OK**.

The selected items are transferred to the Label Printer.
Back up Templates or Other Data Saved in the Label Printer

Use the following procedure to retrieve templates or other data saved in the Label Printer and save it on the computer.

**IMPORTANT**

- Backed up templates or other data cannot be edited on the computer.
- Depending on the Label Printer model, backed up templates or data may not be transferable between different models.

1. Connect the computer and the Label Printer and turn on the Label Printer. The Label Printer model name appears next to a printer icon in the folder view. If you select the Label Printer in the folder view, the current templates and other data stored in the Label Printer appear.

2. Select the Label Printer to back up from, and then click **Backup**. A confirmation message appears.

3. Click **OK**. A new folder is created under the Label Printer in the folder view. The folder name is based on the date and time of the backup. All of the Label Printer's templates and other data are transferred to the new folder and saved on the computer.
Delete Label Printer Data

Use the following procedure to delete all templates or other data saved on the Label Printer.

1. Connect the computer and the Label Printer and turn on the Label Printer. The Label Printer model name appears next to a printer icon in the folder view.

2. Right-click the Label Printer, and then select **Delete All**.

A confirmation message appears.

3. Click **OK**. All templates and other data saved in the Label Printer is deleted.
Create Transfer Files and Transfer Package Files

You can use P-touch Transfer Manager to save template data created using P-touch Editor in .blf or .pdz format. You can transfer these files in this format to a Label Printer over a network, from a computer or mobile device. You can also print files in the .blf format from mass storage mode.

1. Create the template using P-touch Editor, and then transfer it to P-touch Transfer Manager. For more information, see Transfer the Template to P-touch Transfer Manager on page 93.

2. Without connecting the Label Printer to the computer, select Configurations in the P-touch Transfer Manager window, and then select the template to save.

Note
You can select multiple templates at the same time.

3. Click File > Save Transfer File.

IMPORTANT
The Save Transfer File button appears only if the Label Printer is disconnected from the computer or offline.

Note
• If you click Save Transfer File after selecting Configurations, all templates in the folder are saved as the Transfer file (.blf) or Transfer Package file (.pdz).
• You can combine multiple templates into a single Transfer file (.blf) or Transfer Package file (.pdz).

4. In the Save as type field, select the template format you want, and then type in the name and save the template.
   Select the .blf format when printing using the mass storage mode or connecting your mobile device to the Label Printer using Wireless Direct or Wi-Fi, and select the .pdz format when connecting using Bluetooth.
   The templates are saved as a Transfer file (.blf) or Transfer Package file (.pdz).
P-touch Library

This program allows you to manage and print P-touch Editor templates.

Start P-touch Library

- For Windows® 7 / Windows Server® 2008 / Windows Server® 2008 R2:
  Click Start > All Programs > Brother P-touch > P-touch Tools > P-touch Library 2.3.
- For Windows® 8 / Windows® 8.1 / Windows Server® 2012 / Windows Server® 2012 R2:
  On the Apps screen, click P-touch Library 2.3.
- For Windows® 10 / Windows Server® 2016:
  Click Start > P-touch Library 2.3 under Brother P-touch.

When P-touch Library starts, the Main window appears.

Main window

1 Menu Bar
Provides access to all available commands, which are grouped under each menu title (File, Edit, View, Tool, and Help) according to their functions.

2 Toolbar
Provides access to frequently used commands.

3 Folder List
Displays a list of folders. When you select a folder, the templates in the selected folder appear in the templates list.
4 Templates List
Displays a list of the templates in the selected folder.

5 Preview
Displays a preview of the templates selected in the templates list.

Explanations of the Toolbar Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Button name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Open</td>
<td>Opens the selected template.</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td>Prints the selected template with the Label Printer.</td>
</tr>
<tr>
<td></td>
<td>Search</td>
<td>Allows you to search for templates registered to P-touch Library.</td>
</tr>
<tr>
<td></td>
<td>Display Style</td>
<td>Changes the file display style.</td>
</tr>
</tbody>
</table>
Open and Edit Templates

Select the template you want to open or edit, and then click Open.

The program associated with the template launches, allowing you to edit the template.
Print Templates

Select the template you want to print, and then click Print.

The connected Label Printer prints the template.
Search for Templates

You can search for templates registered to P-touch Library.

1. Click **Search**. The **Search** dialog box appears.

   ![Search dialog box](image)

   ABC Company
   Phone XXXXXXXXXX

2. Specify the search criteria. The following search criteria are available:

<table>
<thead>
<tr>
<th>Settings</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Multiple Parameters</strong></td>
<td>Determines how the program searches when multiple criteria are specified. If you select <strong>AND</strong>, the program searches for files that satisfy all of the criteria. If you select <strong>OR</strong>, the program searches for files that satisfy any of the criteria.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Search for a template by specifying the file name.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Search for a template by specifying the file type.</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>Search for a template by specifying the file size.</td>
</tr>
<tr>
<td><strong>Date</strong></td>
<td>Search for a template by specifying the file date.</td>
</tr>
</tbody>
</table>

3. Click **Begin Search**. The search begins and the search results are displayed.
4 Close the Search dialog box.
To confirm the search results, click Search Results in the folder view.

Note
You can register templates to P-touch Library by dragging and dropping them into the All Contents folder or to the folder list. You can also configure P-touch Editor to register templates to P-touch Library automatically, using the following procedure:

1 From the P-touch Editor menu, select Tools > Options.
2 In the Options dialog box, click General > Registration Settings.
3 Select the timing for registering templates created with P-touch Editor, and then click OK.
You can transfer templates to the Label Printer using P-touch Transfer Express. First, the administrator creates a template, and then distributes it together with P-touch Transfer Express. You can then use P-touch Transfer Express to transfer the template directly to your Label Printer.

To download the latest version of P-touch Transfer Express, visit support.brother.com and go to your model's Downloads page.

**IMPORTANT**

- When transferring a new template, make sure you specify a **Key Assign** number (in P-touch Transfer Manager) that is not currently used. If the specified **Key Assign** number is already being used, the existing template will be overwritten with the new one.
- This function requires a USB connection.

---

**Preparing P-touch Transfer Express**

You must prepare P-touch Transfer Express for transferring templates to a Label Printer.

**IMPORTANT**

- The printer driver must be installed before using Transfer Express.
- P-touch Transfer Express is available only in English.

To download the latest version of P-touch Transfer Express, visit support.brother.com and go to your model's Downloads page.

1. Download Transfer Express to any location on the computer.
2. Decompress the downloaded file (.zip).
Transfer the Template to P-touch Transfer Manager

1. In P-touch Editor, open the template you want to use.
2. Click **File > Transfer Template > Transfer**.

The template is transferred to P-touch Transfer Manager. P-touch Transfer Manager automatically starts up.

**Note**

- **For Windows® 7 / Windows Server® 2008 / Windows Server® 2008 R2:**
  The template can also be transferred to P-touch Transfer Manager by clicking **Start > All Programs > Brother P-touch > P-touch Tools > P-touch Transfer Manager 2.3** to start P-touch Transfer Manager, and then dragging the .lbx file to the P-touch Transfer Manager window.

- **For Windows® 8 / Windows® 8.1 / Windows Server® 2012 / Windows Server® 2012 R2:**
  The template can also be transferred to P-touch Transfer Manager by clicking **P-touch Transfer Manager 2.3** on the **Apps** screen to start P-touch Transfer Manager, and then dragging the .lbx file to the P-touch Transfer Manager window.

- **For Windows® 10 / Windows Server® 2016:**
  The template can also be transferred to P-touch Transfer Manager by clicking **Start > Brother P-touch > P-touch Transfer Manager 2.3** to start P-touch Transfer Manager, and then dragging the .lbx file to the P-touch Transfer Manager window.
Save the Template as a Transfer Package File (.pdz)

To create a file in a format that can be used by P-touch Transfer Express, save the template as a Transfer Package file (.pdz).

1. In the folder view, select Configurations.

2. Select the templates you want to distribute.
Click File > Save Transfer File.

IMPORTANT
The Save Transfer File option appears only if the Label Printer is disconnected from the computer or offline.

Note
• If you click Save Transfer File after selecting Configurations or a created folder, all templates in the folder are saved as the Transfer Package file (.pdz).
• You can combine multiple templates into a single Transfer Package file (.pdz).

Type the name, and then click Save.

The template is saved as a Transfer Package file (.pdz).
Distribute the Transfer Package File (.pdz) and P-touch Transfer Express to Others

**Note**
If you already have P-touch Transfer Express downloaded, it is not necessary for the administrator to send the Transfer Express folder. In this case, you can simply move the distributed Transfer Package file to the downloaded folder, and then double-click `PtTrExp.exe`.

1. Move the Transfer Package file (.pdz) to the downloads folder.

2. Distribute all the files in the downloads folder to others.
Transfer the Transfer Package File (.pdz) to Your Label Printer

Using the P-touch Transfer Express application received from the administrator, you can transfer the Transfer Package file (.pdz) to the Label Printer.

**IMPORTANT**

Do not turn off the power when transferring templates.

1. Turn on the Label Printer.
2. Using a USB Cable, connect the Label Printer to the computer.
3. Double-click PtTrExp.exe, which was received from the administrator.
4. Transfer a Transfer Package file (.pdz) to the Label Printer.
   - Transferring a single Transfer Package file (.pdz)
     1. When there is a single Transfer Package file (.pdz) within the folder containing PtTrExp.exe, click Transfer.

2. The transfer of the Transfer Package file begins.
Transferring multiple Transfer Package files (.pdz)

1. When there are multiple Transfer Package files (.pdz) within the folder containing `PtTrExp.exe`, click **Browse**.

2. Select the Transfer Package file you want to transfer, and then click **Open**.

3. Click **Transfer**.
4 Click **Yes**.

5 The transfer of the Transfer Package file begins.

5 When the transfer is complete, click **OK**.
The software can be upgraded to the latest available version using the P-touch Update Software.

**Note**
- The actual software and the contents of this manual may differ.
- Do not turn off the power when transferring data or updating firmware.

**Update P-touch Editor and P-touch Address Book (Windows® only)**

**IMPORTANT**
Before updating P-touch Editor and P-touch Address Book, install the printer driver.

1. Start the P-touch Update Software.
   - **For Windows® 7 / Windows Server® 2008 / Windows Server® 2008 R2:**
     Double-click the P-touch Update Software icon.
   - **Note**
     The following method can also be used to start P-touch Update Software:
     Click Start > All Programs > Brother P-touch > P-touch Update Software.

   - **For Windows® 8 / Windows® 8.1 / Windows Server® 2012 / Windows Server® 2012 R2:**
     Click P-touch Update Software on the Apps screen or double-click P-touch Update Software on the desktop.

   - **For Windows® 10 / Windows Server® 2016:**
     Click Start > Brother P-touch > P-touch Update Software, or double-click P-touch Update Software on the desktop.
How to Update P-touch Software

2 Click the **Computer software update** icon.

![Computer software update icon](image1)

3 Select the **Printer** and **Language**, select the check boxes next to P-touch Editor and P-touch Address Book, and then click **Install**.

![Selecting Printer and Language](image2)

4 A message appears indicating that the installation has finished.

![Installation finished message](image3)
Update the Firmware

**IMPORTANT**
- Before updating the firmware you must install the printer driver.
- Do not turn off the power when transferring data or updating firmware.
- If another application is running, exit the application.

**For Windows®**

1. Turn on the Label Printer and connect the USB Cable.
2. Start the P-touch Update Software.
   - **For Windows® 7 / Windows Server® 2008 / Windows Server® 2008 R2:**
     Double-click the P-touch Update Software icon.
   - **Note**
     The following method can also be used to start P-touch Update Software:
     Click Start > All Programs > Brother P-touch > P-touch Update Software.
   - **For Windows® 8 / Windows® 8.1 / Windows Server® 2012 / Windows Server® 2012 R2:**
     Click P-touch Update Software on the Apps screen or double-click P-touch Update Software on the desktop.
   - **For Windows® 10 / Windows Server® 2016:**
     Click Start > Brother P-touch > P-touch Update Software, or double-click P-touch Update Software on the desktop.
3. Click the **Machine update** icon.

4. Select the **Printer**, make sure that **The machine is connected correctly.** message appears, and then click **OK**.
Select the **Language**, select the check box next to the firmware you want to update to, and then click **Transfer**.

**IMPORTANT**
Do not turn off the Label Printer or disconnect the cable during data transfer.

---

Check the content to be updated, and then click **Start** to begin the update. The firmware update begins.

**IMPORTANT**
Do not turn off the Label Printer or disconnect the cable during the update process.

---

**For Mac**

1. Turn on the Label Printer and connect the USB Cable.
2. Double-click **Macintosh HD > Applications > P-touch Update Software**, and then double-click the **P-touch Update Software** application icon.
3. Click the **Machine update** icon.

4. Select the **Printer**, make sure that **The machine is connected correctly**. message appears, and then click **OK**.

5. Select the **Language**, select the check box next to the firmware you want to update to, and then click **Transfer**.

**IMPORTANT**

Do not turn off the Label Printer or disconnect the cable during data transfer.

6. Check the content you want to update, and then click **Start** to begin the update. The firmware update begins.

**Note**

Do not turn off the Label Printer during the update process.
Network Features

Your Label Printer can be shared on an IEEE 802.11b/g/n wireless network or Ethernet 10BASE-T/100BASE-TX Auto Negotiation wired network using the internal network print server. The print server supports various functions and methods of connection on a network supporting TCP/IP, depending on the operating system you are running.
Change Your Label Printer's Network Settings (IP Address, Subnet Mask, and Gateway)

Using the BRAdmin Light Utility (Windows® only)

The BRAdmin Light utility is designed for the initial setup of Brother network connectable devices. It can also search for Brother products in a TCP/IP environment, display the status, and configure basic network settings, such as the IP address.

Installing BRAdmin Light

1. Visit the Brother Solutions Center at support.brother.com and download the installer for the software and documents.
2. Double-click the downloaded file and follow the on-screen instructions to proceed with the installation. In the dialog box for selecting which items to install, select BRAdmin Light.

Note

• For more advanced Label Printer management, use the latest version of the Brother BRAdmin Professional utility available as a download from the Brother Solutions Center at support.brother.com.
• If using firewall, anti-spyware, or antivirus software, temporarily disable them. When you are sure that you can print, re-enable them.
• The node name appears in the current BRAdmin Light window. The default node name of the print server in the Label Printer is “BRWxxxxxxxxxxxx” or “BRNxxxxxxxxxxxx”. (“xxxxxxxxxxxx” is based on Label Printer’s MAC Address / Ethernet Address.)

Set the IP address, Subnet Mask and Gateway using BRAdmin Light

1. Start the BRAdmin Light utility.
   - For Windows® 7 / Windows Server® 2008 / Windows Server® 2008 R2
     Click Start > All Programs > Brother > BRAdmin Light > BRAdmin Light.
   - For Windows® 8 / Windows® 8.1 / Windows Server® 2012 / Windows Server® 2012 R2
     Click the BRAdmin Light icon on the Apps screen.
   - For Windows® 10 / Windows Server® 2016:
     From the Start button, click BRAdmin Light under Brother.
2. BRAdmin Light automatically searches for new devices.
3. Double-click the unconfigured device.

![BRAdmin Light utility screen]

**Note**

If you do not use a DHCP/BOOTP/RARP server, the device appears as **Unconfigured** in the BRAdmin Light utility screen.

4. Select **STATIC** for **Boot Method**. Type the **IP Address**, **Subnet Mask**, and **Gateway** settings (if needed) for your print server.

![Configure IP Address screen]

5. Click **OK**.

6. Once you setup the IP address, the Brother print server appears in the device list.
Other Management Utilities

Your Label Printer can be used with the following management utilities in addition to the BRAdmin Light utility. You can change your network settings using these utilities.

Use Web Based Management (Web Browser)

A standard web browser can be used to change your print server settings using the HTTP (Hyper Text Transfer Protocol). For more information, see Configure the Printer Settings Using Web Based Management (Web Browser) on page 130.

Use the BRAdmin Professional Utility (Windows® only)

BRAdmin Professional is a utility for more advanced management of network connected Brother devices. This utility can search for Brother products on your network, and display the device status from a simple Explorer style window that changes color to represent the status of each device. You can configure network and device settings along with the ability to update device firmware from a Windows® computer on your Local Area Network (LAN). BRAdmin Professional can also log activity of Brother devices on your network and export the log data.

For more information and downloads, visit the Brother Solutions Center at support.brother.com.

Note

- Use the latest version of the BRAdmin Professional utility available as a download from the Brother Solutions Center at support.brother.com.
- If using firewall, anti-spyware, or antivirus software, temporarily disable them. When you are sure that you can print, re-enable them.
- The node name appears in the current BRAdmin Professional window. The default node name is "BRWxxxxxxxxxxxx" or "BRNxxxxxxxxxxx". ("xxxxxxxxxxx" is based on Label Printer's MAC Address / Ethernet Address.)
Overview

You can use a standard web browser to manage your Label Printer on the network using HTTP. When using Web Based Management, the following operations are available:

- Displaying your Label Printer status information
- Changing network settings, such as TCP/IP information
- Displaying software version information of the Label Printer and print server
- Changing network and Label Printer configuration details

Note

We recommend Microsoft® Internet Explorer® 9/10/11 for Windows®, Safari® 8 or later for Mac.

Make sure JavaScript and cookies are always enabled in the browser you use.

To use Web Based Management, your network must use TCP/IP, and the Label Printer and computer must have a valid IP address.
Configure the Printer Settings Using Web Based Management (Web Browser)

A standard web browser can be used to change your print server settings using the HTTP (Hyper Text Transfer Protocol).

1. In your browser's address bar, type the IP address of your Label Printer (or print server name).
   For example: http://192.168.1.2

   **Note**
   If you have edited the hosts file on your computer or are using a Domain Name System, you can also type the DNS name of the print server. As the print server supports TCP/IP and NetBIOS, you can also type the NetBIOS name of the print server. The NetBIOS name is displayed on the printer settings page. The NetBIOS name assigned is the first 15 characters of the node name and by default it appears as "BRNxxxxxxxxxxxx" where “xxxxxxxxxxxx” is the Ethernet address.

2. You can now change the print server settings.

   **Note**
   **Set a password**
   We recommend setting a logon password to prevent unauthorized access to Web Based Management.

   1. Click **Administrator**.
   2. Type the password you want to use (up to 32 characters).
   3. Re-type the password in the **Confirm new password** field.
   4. Click **Submit**.
      The next time you access Web Based Management, type a password in the **Login** field, and then click .
      After configuring the settings, log off by clicking .

   You can also set a password by clicking **Please configure the password** on the printer’s web page if you are not setting a logon password.
Appendix

Reset the Label Printer 132
Maintenance 133
Troubleshooting 135
Product Specifications 147
Software Development Kit 149
Notes on Using P-touch Transfer Manager 150
Network Terms and Information 152
List of Barcodes for the P-touch Template Function 161
Use the Brother Barcode Scanner (Optional: PA-BR-001) 165
Reset the internal memory of your Label Printer to clear all the saved label files, or if the Label Printer is not operating correctly.

**Reset All Settings to the Factory Settings Using the Label Printer Buttons**

To reset the Label Printer, do the following:

1. Turn off the Label Printer.
2. Press and hold the Power ( ) and Cutter ( ) Buttons for about one second. The Status LED lights in orange and the Wi-Fi LED flashes in green.
3. Continue holding down the Power ( ) Button.
   - Press the Cutter ( ) Button twice to reset the network settings. The Status LED lights in orange.
   - Press the Cutter ( ) Button four times to reset the transfered data and the device settings. The Status LED lights in orange and the Wi-Fi LED lights in green.
   - Press the Cutter ( ) Button six times to reset all the settings and device settings to the factory settings. The Status LED lights in orange, the Wi-Fi LED lights in green and the Bluetooth LED lights in blue.
4. Release the Power ( ) Button. The Status LED flashes orange, the Wi-Fi LED flashes green, and the Bluetooth LED flashes blue for four times. Then, the Status LED lights in orange, the Wi-Fi LED lights in green, and the Bluetooth LED lights in blue.

**Reset Data Using the Printer Setting Tool**

You can use the Printer Setting Tool from a computer to perform the following operations for the Label Printer:

- Delete the templates and databases
- Reset communication settings
- Reset printer settings to factory settings

For more information, see *Change the Label Printer Settings* on page 23.
We recommend cleaning your Label Printer on a regular basis to maintain its correct performance.

Note
Always disconnect the AC Power Cord before cleaning the Label Printer.

Clean the Exterior of the Unit
Wipe any dust and marks from the main unit using a soft, dry cloth. Use a cloth slightly damp with water on difficult to remove marks.

Note
Do not use paint thinner, benzene, alcohol or any other organic solvent. These may deform or damage the Label Printer case.

Clean the Label Outlet
If a label causes the machine to jam due to adhesive residue attached to the label outlet, disconnect the AC Power Cord from the machine and clean it with a cloth or cotton swab dipped in alcohol.
Clean the Roller

Cut the DK label and peel the backing from the label. Then, place the adhesive side of the label against the roller and remove the dirt.

Self-Cleaning Print Head

The DK Roll (thermal recording paper type) used with the machine is designed to clean the print head automatically. When the DK Roll passes the print head during printing and label feeding, the print head is cleaned.
Overview

This chapter explains how to resolve typical problems you may encounter when using the Label Printer. If you have any problems with the Label Printer, first make sure you have performed the following tasks correctly:

- Connect the Label Printer to an AC power outlet. For more information, see Connect the Power Cord on page 4.
- Remove all protective packaging from the Label Printer.
- Install and select the correct printer driver. For more information, see Install Printer Drivers and Software on a Computer on page 9.
- Connect the Label Printer to a computer or mobile device. For more information, see Connect the Label Printer to a Computer on page 10.
- Close the DK Roll Compartment Cover completely.
- Insert a DK Roll correctly. For more information, see Load the DK Roll on page 5.

If you still have problems, read the troubleshooting tips in this chapter for help. If, after reading this chapter, you are unable to resolve your problem, visit the Brother Solutions Center at support.brother.com.
## LED Indications

The indicators light and flash to indicate the Label Printer’s status.

-  or  or  or  Indicator is lit in the color shown
-  or  or  or  Indicator is flashing in the color shown
-  Indicator can be off, lit, or flashing in any color
-  Indicator is off

<table>
<thead>
<tr>
<th>Status LED</th>
<th>Wi-Fi LED</th>
<th>Bluetooth LED</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Power is Off</td>
</tr>
<tr>
<td>[ ]</td>
<td>[ ]</td>
<td>[ ]</td>
<td>Idle mode</td>
</tr>
<tr>
<td>[ ]</td>
<td>[ ]</td>
<td>[ ]</td>
<td>Initializing mode</td>
</tr>
<tr>
<td>[ ]</td>
<td>[ ]</td>
<td>[ ]</td>
<td>Feeding mode</td>
</tr>
<tr>
<td>[ ]</td>
<td>[ ]</td>
<td>[ ]</td>
<td>Printing mode</td>
</tr>
<tr>
<td>[ ]</td>
<td>[ ]</td>
<td>[ ]</td>
<td>Cutting mode</td>
</tr>
<tr>
<td>[ ]</td>
<td>[ ]</td>
<td>[ ]</td>
<td>Mass storage mode</td>
</tr>
<tr>
<td>[ ] (Once for 1 second)</td>
<td>[ ]</td>
<td></td>
<td>Wi-Fi is on and connected</td>
</tr>
<tr>
<td>[ ] (Once for 3 seconds)</td>
<td>[ ]</td>
<td>[ ]</td>
<td>WPS setting mode</td>
</tr>
<tr>
<td>[ ]</td>
<td>[ ]</td>
<td>[ ]</td>
<td>WLAN is on, but not connected</td>
</tr>
<tr>
<td>[ ]</td>
<td>[ ]</td>
<td>[ ]</td>
<td>Wi-Fi is Off</td>
</tr>
<tr>
<td>[ ]</td>
<td>[ ]</td>
<td>[ ]</td>
<td>Bluetooth is On</td>
</tr>
<tr>
<td>[ ]</td>
<td>[ ]</td>
<td>[ ]</td>
<td>Bluetooth pairing</td>
</tr>
<tr>
<td>[ ]</td>
<td>[ ]</td>
<td>[ ]</td>
<td>Receiving data</td>
</tr>
<tr>
<td>[ ]</td>
<td>[ ]</td>
<td>[ ]</td>
<td>Canceling the print job</td>
</tr>
<tr>
<td>[ ]</td>
<td>[ ]</td>
<td>[ ]</td>
<td>Switching to mass storage mode</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Status LED</th>
<th>Wi-Fi LED</th>
<th>Bluetooth LED</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image1" alt="Green LED" /></td>
<td><img src="image2" alt="Blue LED" /></td>
<td>The DK Roll Compartment Cover is open. Close the DK Roll Compartment Cover correctly.</td>
</tr>
<tr>
<td></td>
<td><img src="image1" alt="Green LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>Resetting mode is on. For more information, see Reset All Settings to the Factory Settings Using the Label Printer Buttons on page 132.</td>
</tr>
<tr>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>Label Printer is in System Off mode.</td>
</tr>
<tr>
<td><img src="image1" alt="Green LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image2" alt="Blue LED" /></td>
<td>If the orange light flashes at 0.5 second intervals, the Label Printer is in Cooling mode.</td>
</tr>
<tr>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>Searching for Label Printers.</td>
</tr>
<tr>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>Data overwrite mode.</td>
</tr>
<tr>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>Label Printer is in Boot mode. Contact Brother Customer Service.</td>
</tr>
<tr>
<td><img src="image1" alt="Green LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>Roll end error.</td>
</tr>
<tr>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>No media error.</td>
</tr>
<tr>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>Wrong media error.</td>
</tr>
<tr>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>Feed error.</td>
</tr>
<tr>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>Cover open error.</td>
</tr>
<tr>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>Transferred data error.</td>
</tr>
<tr>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>Memory full error.</td>
</tr>
<tr>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>Access point connection error.</td>
</tr>
<tr>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>Security error.</td>
</tr>
<tr>
<td><img src="image1" alt="Green LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image2" alt="Blue LED" /></td>
<td>Cutter error.</td>
</tr>
<tr>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>Mass storage error.</td>
</tr>
<tr>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>USB host power supply excessive voltage error.</td>
</tr>
<tr>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>USB host unsupported device connection error.</td>
</tr>
<tr>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>USB host HUB connection error.</td>
</tr>
<tr>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td><img src="image3" alt="Gray LED" /></td>
<td>System error. When you press a button other than the Power ( ) Button, the flash pattern changes according to the cause of the error. Contact Brother Customer Service.</td>
</tr>
</tbody>
</table>

---

1 Rapidly = at 0.3 second intervals.
# Printing Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
</table>
| The Status LED is not lit.                                             | Is the AC Power Cord inserted correctly?  
Check that the AC Power Cord is inserted. If it is inserted correctly, try plugging it into another AC power outlet. |
| The Label Printer does not print, or a printing error is received.    | • Is the cable loose?  
Check that the cable is connected securely.  
• Is the DK Roll installed correctly?  
If not, remove the DK Roll and reinstall it.  
• Is there enough roll remaining?  
Check that there is enough roll remaining.  
• Is the DK Roll Compartment Cover open?  
Check that the DK Roll Compartment Cover is closed.  
• Has a print error or transmission error occurred?  
Turn the Label Printer Off and then turn it On again. If there is still a problem, contact your Brother Customer Service.  
• If the Label Printer is connected via a USB hub, try connecting it directly to the computer. If not, try connecting it to another USB port. |
| The printed label contains streaks or poor quality characters, or the label is not fed correctly. | Is the print head or roller dirty?  
While the print head generally remains clean under normal use, lint or dirt from the roller may become stuck on the printer head.  
If this occurs, clean the roller.  
For more information, see Clean the Roller on page 134. |
| A data transmission error appears on the computer.                     | Is the Label Printer in cooling mode (the Status LED is flashing in orange)?  
Wait until the Status LED stops flashing and then try printing again. |
| Labels are jammed in the cutter.                                       | Contact Brother Customer Service. |
| The label is not ejected correctly after printing.                    | • Check that the Label Output Slot is not blocked.  
• Check that the DK Roll is set correctly by removing the DK Roll and reinstalling it.  
• Ensure that the DK Roll Compartment Cover is closed correctly. |
| I want to cancel the current printing job.                             | Make sure that the Label Printer is On, and press the Power (وجب) Button. |
| The print quality is poor.                                             | Is there dirt or lint on the roller preventing it from rolling freely?  
For more information, see Clean the Roller on page 134. |
| After replacing the Roll while the Add-In feature was activated, the layout style was not updated. | Close P-touch Editor to exit the Add-In, and then reactivate the Add-In. |
| The P-touch Add-In icon is not displayed in Microsoft® Word.           | • Is Microsoft® Word started up from Microsoft® Outlook®?  
• Is Microsoft® Word chosen as the default editor for Microsoft® Outlook®?  
Due to program limitations, the Microsoft® Word Add-In does not work with the above settings. Quit Microsoft® Outlook®, and restart Microsoft® Word. |
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Received data in buffer</td>
<td>Print data is saved in the buffer. If the Label Printer has not received the complete data, printing will not start.</td>
</tr>
<tr>
<td></td>
<td>Turn off the Label Printer, and then turn it on again.</td>
</tr>
<tr>
<td>Label Printer is in cooling</td>
<td>The thermal head is too hot.</td>
</tr>
<tr>
<td>mode</td>
<td>The Label Printer stops and resumes printing only after the thermal head has cooled down. The head may become too hot if you are printing a large number of labels.</td>
</tr>
<tr>
<td></td>
<td>When the thermal head becomes too hot, it may produce imaging outside the print area. To avoid or delay overheating, make sure the Label Printer has adequate ventilation and is not located in an enclosed space.</td>
</tr>
<tr>
<td></td>
<td>If the Label Printer must cool down because it overheated due to the type of DK Roll you are using or the contents of the label, printing may take longer than usual.</td>
</tr>
<tr>
<td>Note</td>
<td>This condition may occur more often when the Label Printer is used at high altitude (more than 10,000 ft (3,048 m)) due to a lower air density available to cool the Label Printer.</td>
</tr>
<tr>
<td>DK Roll errors</td>
<td>Check the following:</td>
</tr>
<tr>
<td></td>
<td>• You are using the correct DK Roll.</td>
</tr>
<tr>
<td></td>
<td>• There are enough labels remaining.</td>
</tr>
<tr>
<td></td>
<td>• The DK Roll is installed correctly.</td>
</tr>
<tr>
<td>Cutter error</td>
<td>If a cutter error occurs, keep the DK Roll Compartment Cover closed and press the Power ( ) Button. The cutter moves back to the normal position and the Label Printer turns off automatically.</td>
</tr>
<tr>
<td></td>
<td>After the Label Printer is Off, check the label outlet and remove any jammed labels. Contact Brother Customer Service.</td>
</tr>
<tr>
<td>Unable to reset an error</td>
<td>To reset an error:</td>
</tr>
<tr>
<td></td>
<td>1 Open the DK Roll Compartment Cover, and then close it.</td>
</tr>
<tr>
<td></td>
<td>2 If the error is not reset, press the Cutter ( ) Button.</td>
</tr>
<tr>
<td></td>
<td>3 If the error is not reset, turn off the Label Printer, and then turn it on again.</td>
</tr>
<tr>
<td></td>
<td>4 If the error is not reset, contact Brother Customer Service.</td>
</tr>
<tr>
<td>I want to reset the Label</td>
<td>You can reset the Label Printer using the Printer Setting Tool from a computer. For more information, see Change the Label Printer Settings on page 23.</td>
</tr>
<tr>
<td>Printer.</td>
<td>You can reset the Label Printer using the Printer buttons. For more information, see Reset All Settings to the Factory Settings Using the Label Printer Buttons on page 132.</td>
</tr>
</tbody>
</table>
When printing via the USB Cable, the Label Printer repeatedly pauses and then continues printing.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Is the Label Printer set for sequential printing?</td>
<td></td>
</tr>
<tr>
<td>If so, set print mode to buffered printing.</td>
<td></td>
</tr>
<tr>
<td><strong>For Windows® 7 / Windows Server® 2008 / Windows Server® 2008 R2:</strong></td>
<td></td>
</tr>
<tr>
<td>Open the printer properties by clicking Start &gt; Devices and Printers,</td>
<td></td>
</tr>
<tr>
<td>right-clicking the Label Printer you want to set up, and then clicking</td>
<td></td>
</tr>
<tr>
<td>Printing preferences.</td>
<td></td>
</tr>
<tr>
<td>Click the Other tab and select the option After one page of data is</td>
<td></td>
</tr>
<tr>
<td>received.</td>
<td></td>
</tr>
<tr>
<td>**For Windows® 8 / Windows® 8.1 / Windows Server® 2012 / Windows</td>
<td></td>
</tr>
<tr>
<td>Server® 2012 R2:**</td>
<td></td>
</tr>
<tr>
<td>Open the printer properties by clicking Control Panel in the Apps screen</td>
<td></td>
</tr>
<tr>
<td>&gt; Hardware and Sound &gt; Devices and Printers, right-clicking the Label</td>
<td></td>
</tr>
<tr>
<td>Printer you want to set up, and then clicking Printing preferences.</td>
<td></td>
</tr>
<tr>
<td>Click the Other tab and select the option After one page of data is</td>
<td></td>
</tr>
<tr>
<td>received.</td>
<td></td>
</tr>
<tr>
<td><strong>For Windows® 10 / Windows Server® 2016:</strong></td>
<td></td>
</tr>
<tr>
<td>Open the printer properties by clicking Start &gt; Settings &gt; Devices &gt;</td>
<td></td>
</tr>
<tr>
<td>Printers &amp; scanners &gt; Devices and Printers, right-clicking the Label</td>
<td></td>
</tr>
<tr>
<td>Printer you want to set up, and then clicking Printing preferences.</td>
<td></td>
</tr>
<tr>
<td>Click the Other tab and select the option After one page of data is</td>
<td></td>
</tr>
<tr>
<td>received.</td>
<td></td>
</tr>
<tr>
<td>• An alternative solution is to disconnect the LAN cable until USB</td>
<td></td>
</tr>
<tr>
<td>printing is completed.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Solution</td>
</tr>
<tr>
<td>---------</td>
<td>----------</td>
</tr>
</tbody>
</table>
| Printed barcodes cannot be read. | - Print labels so that barcodes are aligned with the print head as shown below:  

1. **Print head**  
2. **Barcodes**  
3. **Printing orientation**  

- Barcodes may not be read if they are reduced or enlarged.  
- Try using another scanner.  
- We recommend printing barcodes with Print Quality options set to **Give priority to print quality**.  

**For Windows® 7 / Windows Server® 2008 / Windows Server® 2008 R2:**  
To display the **Quality** options, open the printer properties by clicking **Start** > **Devices and Printers**, right-clicking the Label Printer you want to set up, and then clicking **Printing preferences**.  

**For Windows® 8 / Windows® 8.1 / Windows Server® 2012 / Windows Server® 2012 R2:**  
To display the **Quality** options, open the printer properties by clicking **Control Panel** in the **Apps** screen > **Hardware and Sound** > **Devices and Printers**, right-clicking the Label Printer you want to set up, and then clicking **Printing preferences**.  

**For Windows® 10 / Windows Server® 2016:**  
To display the **Quality** options, open the printer properties by clicking **Start** > **Settings** > **Devices** > **Printers & scanners** > **Devices and Printers**, right-clicking the Label Printer you want to set up, and then clicking **Printing preferences**.  

**For Mac:**  
To change the Print Quality options, open the **Print** dialog box and select **Basic** from the print options pop-up menu.
## Problem

Barcodes printed using applications other than P-touch Editor cannot be read.

## Solution

If the barcode data was created using a landscape orientation, change the Orientation setting in the Basic tab of the printer driver to Landscape and try again.

![Printer Driver Settings](image)
## Network Setup Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
</table>
| You are using security software                                        |  ■ Confirm your settings in the installation dialog box.  
  ■ Allow access when the security software alert message appears during the Label Printer installation.                  |
| Your security settings (SSID/Network Key) are incorrect                |  ■ Recheck and select the correct security settings.  
  ■ The manufacturer’s name or model number of the wireless access point/router may be used as the default security settings.  
  ■ See the instructions supplied with your wireless access point/router for information on how to find the security settings.  
  ■ Ask the wireless access point/router manufacturer, ask your Internet provider, or network administrator. |
| Your Label Printer cannot connect to the host device using Wi-Fi or Bluetooth. |  ■ Move your Label Printer within about 3.3 feet (one meter) of the mobile device when you configure the Wi-Fi network settings.  
  ■ Move your Label Printer to an obstruction-free area.                                                                 |
| Your Label Printer cannot print using Wi-Fi or Bluetooth.              |  ■ If a wireless computer, Bluetooth-equipped device, microwave oven, digital cordless phone, or other device is near your Label Printer or the wireless access point/router, move the device away from your Label Printer or wireless access point/router. |
| There are obstructions (walls or furniture, for example) between your Label Printer and the mobile device | Move your Label Printer to an obstruction-free area.                                                                                     |
| A wireless computer, Bluetooth supported device, microwave oven or digital cordless phone is near the Label Printer or the wireless access point/router | Move other devices away from the Label Printer.                                                                                          |
| You are using MAC Address filtering                                    | You can confirm the MAC address by printing the Printer Settings Report.  
  For more information, see Confirm Label Printer Settings on page 65.                                                               |
| Your wireless access point/router is in stealth mode (not broadcasting the SSID) |  ■ You must type the correct SSID name during the installation or when using the Printer Setting Tool.  
  ■ Check the SSID name in the instructions supplied with your wireless access point/router and reconfigure the Wi-Fi settings. |
### Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Your Label Printer is not connected correctly to the network           | - Check that the Label Printer is in the mode you want to connect to.  
|                                                                       | - If the Label Printer is still not connected, please try the following:  
|                                                                       |   - For Wi-Fi connection  
|                                                                       |     (flashes every three seconds): The network is connected incorrectly, and the Wi-Fi settings must be reconfigured.  
|                                                                       |   - For Wireless Direct  
|                                                                       |     Search for the Label Printer from the Wi-Fi device.  
|                                                                       |   - For Wired LAN  
|                                                                       |     Check that the LAN cable is connected correctly.  
|                                                                       |   - For Bluetooth  
|                                                                       |     ![Logo] Search for the Label Printer from the device you want to connect. |
| I have checked and tried all of the above, but still cannot complete the Wi-Fi/Bluetooth settings | Turn off the Label Printer, and then turn it on again. Then, try and configure the Wi-Fi and Bluetooth settings again. |
| Your Label Printer is not connected if the Bluetooth connection with an Apple device (iPad, iPhone, or iPod touch) is lost. | Turn On the Auto Reconnect function.  
|                                                                       | You can set it from the Printer Setting Tool. For more information, see Change the Label Printer Settings on page 23. |
## Label Printer Cannot Print over the Network

### Label Printer Is Not Found on the Network Even after Successful Installation

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You are using security software</td>
<td>See Security Software Problems on page 145.</td>
</tr>
<tr>
<td>Your Label Printer is not assigned with an available IP address</td>
<td>Confirm the IP address and the Subnet Mask. Verify that both the IP addresses and Subnet Masks of your computer and your Label Printer are correct and located on the same network. For more information on how to verify the IP address and the Subnet Mask, ask the network administrator. Confirm your IP address, Subnet Mask and other network settings using the Printer Setting Tool. For more information, see Change the Label Printer Settings on page 23.</td>
</tr>
<tr>
<td>Your previous printing job failed</td>
<td>If the failed printing job is still in your computer's print queue, delete it. For example, when using Windows® 7: Devices and Printers and select the Label Printer from Printers and Faxes. Double-click the Label Printer's icon, and then select Cancel All Documents in the Printer menu.</td>
</tr>
<tr>
<td>I have checked and tried all of the above, but my Label Printer does not print</td>
<td>Uninstall the printer driver and the software, and then reinstall them.</td>
</tr>
</tbody>
</table>

### Security Software Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You did not select to allow access when the Security Alert dialog box appeared during either the standard installation, BRAdmin Light installation, or when printing</td>
<td>If you did not select to allow access when the Security Alert dialog box appeared, the firewall function of your security software may be blocking access. Some security software may block access without displaying a Security Alert dialog box. To allow access, refer to your security software instructions or ask the manufacturer.</td>
</tr>
<tr>
<td>Incorrect port numbers are being used for the Brother network features</td>
<td>The following port numbers are used for Brother network features: BRAdmin Light – Port number 161 / Protocol UDP For more information on how to open the port, refer to your security software instructions or ask the manufacturer.</td>
</tr>
</tbody>
</table>
## Checking the Operation of Network Devices

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your Label Printer and wireless access point/router are not turned on</td>
<td>Make sure you have performed all of the tasks on page 135.</td>
</tr>
<tr>
<td>I do not know my Label Printer network settings, such as the IP address</td>
<td>Check the Printer Setting Tool. For more information, see Change the Label Printer Settings on page 23.</td>
</tr>
</tbody>
</table>

## Version Information

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
</table>
| I do not know the version number of the firmware for the Label Printer. | To check for the latest firmware:  
  1. Turn your Label Printer on.  
  2. Press and hold the Cutter (₃ |_| ) Button for several seconds to print the report.  
    We recommend you use a 2.4” (62 mm) or wider DK Roll. |
| I want to confirm whether I am using the latest version of the software. | Use the P-touch Update Software to confirm whether you have the latest version.  
For more information about the P-touch Update Software, see How to Update P-touch Software on page 118. |
# Product Specifications

## Label Printer Specifications

### Size

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>Approximately 6.70 (W) x 8.75 (D) x 5.95 (H) in./170 (W) x 222 (D) x 151 (H) mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>Approximately 3.83 lb (1,735 g) (without DK Rolls)</td>
</tr>
</tbody>
</table>

### LED Indicators

- Status LED, Bluetooth LED, Wi-Fi LED

### Buttons

- Power Button, Feed Button, Cutter Button, Bluetooth Button, Wi-Fi Button, WPS Button

### Printing

<table>
<thead>
<tr>
<th>Method</th>
<th>Direct thermal printing via thermal head</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print head</td>
<td>300 dpi / 1296 dots</td>
</tr>
<tr>
<td>Print resolution</td>
<td>300 dpi × 300 dpi</td>
</tr>
<tr>
<td>Printing speed</td>
<td>Max. 4.3”/sec. (110 mm/sec.)</td>
</tr>
<tr>
<td>Actual print speed</td>
<td>varies depending on the conditions.</td>
</tr>
<tr>
<td>Maximum printing capability (width)</td>
<td>4” (101.6 mm)               There is a chance that you may not be able to print in full width depending on your environment. For the details, see our website, support.brother.com. Note: We recommend designing with enough margin, because there is a possibility of cut off if the paper is not fed in straight.</td>
</tr>
</tbody>
</table>

### Interface

<table>
<thead>
<tr>
<th>USB</th>
<th>Version 2.0 Full Speed (Peripheral)</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB Host</td>
<td>HID class</td>
</tr>
<tr>
<td>Wi-Fi</td>
<td>• Wireless Direct: IEEE 802.11g/n</td>
</tr>
<tr>
<td></td>
<td>• Infrastructure mode: IEEE 802.11b/g/n</td>
</tr>
<tr>
<td></td>
<td>• WPS 2.0</td>
</tr>
<tr>
<td>LAN Port</td>
<td>10BASE-T/100BASE-TX</td>
</tr>
<tr>
<td>Bluetooth</td>
<td>• Version 2.1 + EDR</td>
</tr>
<tr>
<td></td>
<td>• Supported profiles: SPP, OPP, BIP, HCRP</td>
</tr>
<tr>
<td></td>
<td>• Supported protocol: iAP</td>
</tr>
</tbody>
</table>

### Power Supply

<table>
<thead>
<tr>
<th>Power Supply</th>
<th>120 V AC  60 Hz 1.6 A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Power-off</td>
<td>Off/1/2/4/8/12 Hours</td>
</tr>
<tr>
<td></td>
<td>(To change the Auto Power-off setting, see Change the Label Printer Settings on page 23.)</td>
</tr>
</tbody>
</table>

### Other

| Cutter                 | Durable automatic cutter                                                          |
### Environment

<table>
<thead>
<tr>
<th></th>
<th>Operating temperature/humidity</th>
<th>Storage temperature/humidity</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating temperature/humidity</strong></td>
<td>50°F to 95°F (10°C to 35°C) / 20% to 80% (Maximum wet-bulb temperature 80.6°F (27°C))</td>
<td>-4°F to 140°F (-20°C to 60°C) / 5% to 95% (Maximum wet-bulb temperature 113°F (45°C))</td>
</tr>
</tbody>
</table>

**Compatible operating systems**

See support.brother.com for a complete and updated list of software.
A Software Development Kit (SDK) is available. Visit the Brother Developer Center (www.brother-usa.com/lp/civ/home.aspx).

The b-PAC SDK and the SDKs for mobile devices (Android, iPhone, and iPad) can also be downloaded. (The SDKs available are subject to change without notice.)
Notes on Using P-touch Transfer Manager

Because some P-touch Editor functions are not available with the Label Printer, keep the following points in mind when using P-touch Editor to create templates.

You can check a preview of the printed template before the created template is transferred to the Label Printer. For more information, see Transfer the Template to P-touch Transfer Manager on page 93.

Notes on Creating Templates

- Some of the text in the template that is transferred to the Label Printer will be printed using similar fonts and character sizes that are loaded in the Label Printer. As a result, the printed label may differ from the image of the template created in P-touch Editor.
- Depending on the text object setting, the character size may be automatically reduced or some of the text may not be printed. If this occurs, change the text object setting.
- Although character styles can be applied to individual characters with P-touch Editor, styles can be applied to a block of text only with the Label Printer. In addition, some character styles are not available on the Label Printer.
- Backgrounds specified with P-touch Editor are not compatible with the Label Printer.
- A P-touch Editor layout that uses the split printing function (enlarging the label and printing it on two or more labels) cannot be transferred.
- Only the portion of the label within the printable area is printed.
- Fields that overflow the print area may not be printed completely.

Notes on Transferring Templates

- The printed label may differ from the image that appears in the preview area of P-touch Transfer Manager.
- If a barcode not loaded on the Label Printer is transferred to the Label Printer, the barcode will be converted into an image if it is a 2-dimensional barcode. The image of the converted barcode cannot be edited.
- All transferred objects that cannot be edited by the Label Printer are converted into images.
- Grouped objects will be converted into a single bitmap.
Notes on Transferring Data Other Than Templates

- If the number or order of fields in a database is changed and only the database (.csv file) is transferred to update it, the database may not link correctly with the template. In addition, the first line of data in the transferred file must be recognized by the Label Printer as “field names”.

- Logos, symbols, and graphics downloaded to the Label Printer will automatically be scaled to the resident font or any of the resident symbols in the library.
### Supported Protocols and Security Features

<table>
<thead>
<tr>
<th>Interface</th>
<th>Wireless</th>
<th>IEEE 802.11b/g/n (Infrastructure Mode)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>IEEE 802.11g/n (Wireless Direct Mode)</td>
</tr>
<tr>
<td>Ethernet</td>
<td>Ethernet 10BASE-T/100BASE-TX Auto Negotiation</td>
<td></td>
</tr>
<tr>
<td>Network Protocol (IPv4)</td>
<td>ARP, RARP, BOOTP, DHCP, APIPA (Auto IP), mDNS, WINS, NetBIOS name resolution, DNS Resolver, LPR/LPD, Custom Raw Port/Port9100, FTP Server, TFTP client and server, SNTP client, ICMP, LLMNR responder, SNMPv1/v2c</td>
<td></td>
</tr>
<tr>
<td>Network Protocol (IPv6)</td>
<td>NDP, RA, DNS Resolver, LPR/LPD, mDNS, Custom Raw Port/Port9100, FTP Server, TFTP client and server, ICMP, LLMNR responder, SNMPv1/v2c</td>
<td></td>
</tr>
</tbody>
</table>

| Network (Security) | Wireless | WEP 64/128 bit, WPA/WPA2-PSK, LEAP, EAP-FAST, PEAP, EAP-TTLS, EAP-TLS |
Types of Network Connections and Protocols

You will find basic information about the advanced network features of the Label Printer, along with general networking and common terms.

The supported protocols and network features differ depending on the model you are using.

Types of Network Connections

Peer-to-Peer printing using TCP/IP

In a Peer-to-Peer environment, each computer directly sends and receives data to each device. There is no central server controlling file access or Label Printer sharing.

1 Router

- In a smaller network of two or three computers, we recommend the Peer-to-Peer printing method as it is easier to configure than the Network Shared printing method. See Network Shared printing on page 154.
- Each computer must use the TCP/IP Protocol.
- Your Label Printer needs an appropriate IP address configuration.
- If using a router, you must configure the Gateway address on the computers and your Label Printer.
Network Shared printing

In a Network Shared environment, each computer sends data via a centrally controlled computer. This type of computer is often called a “Server” or a “Print Server”. Its job is to control the printing of all print jobs.

1 Client computers
2 Also known as “Server” or “Print server”
3 TCP/IP or USB

- In a larger network, we recommend using a Network Shared printing environment.
- The “server” or the “print server” must use the TCP/IP print protocol.
- Your Label Printer needs to have an appropriate IP address configuration, except when the Label Printer is connected via the USB interface to the server.
Configure Your Label Printer for a Network

IP Addresses, Subnet Masks and Gateways

To use the Label Printer in a networked TCP/IP environment, you must configure its IP address and subnet mask. The IP address you assign to the print server must be on the same network as your host computers. If it is not, you must correctly configure the subnet mask and the gateway address.

IP address

An IP address is a series of numbers that identifies each device connected to a network. An IP address consists of four numbers separated by dots. Each number is between 0 and 254.

- For example in a small network, you would normally change the final number:
  - 192.168.1.1
  - 192.168.1.2
  - 192.168.1.3

How the IP address is assigned to your print server:

If you have a DHCP/BOOTP/RARP server on your network, the print server will automatically obtain its IP address from that server.

Note

On smaller networks, the DHCP server may also be the router.

If you do not have a DHCP/BOOTP/RARP server, the Automatic Private IP Addressing (APIPA) protocol will automatically assign an IP address from the range 169.254.0.1 to 169.254.254.254. The subnet mask is automatically set to 255.255.0.0 and the gateway address is set to 0.0.0.0.

By default, the APIPA protocol is enabled. To disable the APIPA protocol, use BRAdmin Light or Web Based Management (web browser).
Subnet mask
Subnet masks restrict network communication.  
- For example, Computer 1 can communicate with Computer 2  
  - Computer 1  
    IP Address: 192.168.1.2  
    Subnet Mask: 255.255.255.0  
  - Computer 2  
    IP Address: 192.168.1.3  
    Subnet Mask: 255.255.255.0  

The 0 in the Subnet mask signifies that there is no limit to communication at this part of the address. In the example above, this means that you can communicate with any device with an IP address that begins with 192.168.1.x. (where x is a number between 0 and 254).

Gateway (and router)
A gateway is a network point that acts as an entrance to another network and sends data transmitted via the network to an exact destination. The router knows where to direct data that arrives at the gateway. If a destination is located on an external network, the router transmits data to the external network. If your network communicates with other networks, you may need to configure the Gateway IP address. If you do not know the Gateway IP address, contact your network administrator.
Wireless Network Terms and Concepts

Security Terms

Authentication and encryption
Most wireless networks use some kind of security settings. These security settings define the authentication (how the device identifies itself to the network) and encryption (how the data is encrypted as it is sent on the network). **If you do not correctly specify these options when you are configuring your Brother wireless printer, it will not be able to connect to the wireless network.** Make sure you configure these options carefully.

Authentication and Encryption methods for a personal wireless network
A personal wireless network is a small network, for example using your Label Printer in a wireless network at home, without IEEE 802.1x support.
To use your Label Printer in an IEEE 802.1x supported wireless network, see *Authentication and Encryption methods for an enterprise wireless network* on page 158.

Authentication methods

- **Open system**
  
  Wireless devices are allowed to access the network without any authentication.

- **Shared key**
  
  A secret pre-determined key is shared by all devices that will access the wireless network.
  
  The Brother wireless printer uses a WEP key as the pre-determined key.

- **WPA-PSK**
  
  Enables a Wi-Fi Protected Access Pre-shared key (WPA-PSK), which enables the Brother wireless printer to associate with access points using TKIP for WPA-PSK.

- **WPA2-PSK**
  
  Enables a Wi-Fi Protected Access Pre-shared key (WPA2-PSK), which enables the Brother wireless printer to associate with access points using AES for WPA2-PSK (WPA-Personal).

- **WPA/WPA2-PSK**
  
  Enables a Wireless Protected Access Pre-shared key (WPA-PSK/WPA2-PSK), which enables the Brother wireless printer to associate with access points using TKIP for WPA-PSK or AES for WPA-PSK and WPA2-PSK (WPA-Personal).

Encryption methods

- **None**
  
  No encryption method is used.

- **WEP**
  
  When using WEP (Wired Equivalent Privacy), the data is transmitted and received with a secure key.
TKIP
TKIP (Temporal Key Integrity Protocol) provides per-packet key mixing, a message integrity check and rekeying mechanism.

AES
Advanced Encryption Standard (AES) provides stronger data protection using a symmetric-key encryption.

When [Communication Mode] is set to [Ad-hoc]

<table>
<thead>
<tr>
<th>Authentication Method</th>
<th>Encryption Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open System</td>
<td>None / WEP</td>
</tr>
</tbody>
</table>

When [Communication Mode] is set to [Infrastructure]

<table>
<thead>
<tr>
<th>Authentication Method</th>
<th>Encryption Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open System</td>
<td>None / WEP</td>
</tr>
<tr>
<td>Public Key Authentication</td>
<td>WEP</td>
</tr>
<tr>
<td>WPA/WPA2-PSK</td>
<td>TKIP+AES / AES</td>
</tr>
</tbody>
</table>

Network key

Open system/Shared key with WEP
This key is a 64-bit or 128-bit value that must be entered in an ASCII or hexadecimal format.
- 64 (40) bit ASCII:
  Uses five text characters. For example, “WSLAN” (case-sensitive)
- 64 (40) bit hexadecimal:
  Uses 10 digits of hexadecimal data. For example, “71f2234aba”
- 128 (104) bit ASCII:
  Uses 13 text characters. For example, “Wirelesscomms” (case-sensitive)
- 128 (104) bit hexadecimal:
  Uses 26 digits of hexadecimal data. For example, “71f2234ab56cd709e5412aa2ba”

WPA/WPA2-PSK and TKIP with AES
Uses a Pre-Shared Key (PSK) that is eight or more characters in length, up to a maximum of 63 characters.

Authentication and Encryption methods for an enterprise wireless network
An enterprise wireless network is a large network with IEEE 802.1x support. If you configure your printer in an IEEE 802.1x supported wireless network, you can use the following authentication and encryption methods:
Authentication methods

- LEAP (For wireless network)
  Cisco LEAP (Light Extensible Authentication Protocol) has been developed by Cisco Systems, Inc. and uses a user ID and password for authentication.

- EAP-FAST
  EAP-FAST (Extensible Authentication Protocol-Flexible Authentication via Secured Tunnel) has been developed by Cisco Systems, Inc. and uses a user ID and password for authentication, and symmetric key algorithms to achieve a tunnelled authentication process.

  The printer supports the following inner authentication methods:
  - EAP-FAST/NONE
  - EAP-FAST/MS-CHAPv2
  - EAP-FAST/GTC

- PEAP
  PEAP (Protected Extensible Authentication Protocol) has been developed by Microsoft Corporation, Cisco Systems and RSA Security. PEAP creates an encrypted SSL (Secure Sockets Layer)/TLS (Transport Layer Security) tunnel between a client and an authentication server, for sending a user ID and password. PEAP provides mutual authentication between the server and the client.

  The printer supports the following inner authentication methods:
  - PEAP/MS-CHAPv2
  - PEAP/GTC

- EAP-TTLS
  EAP-TTLS (Extensible Authentication Protocol Tunnelled Transport Layer Security) has been developed by Funk Software and Certicom. EAP-TTLS creates a similar encrypt SSL tunnel to PEAP, between a client and an authentication server, for sending a user ID and password. EAP-TTLS provides mutual authentication between the server and the client.

  The printer supports the following inner authentication methods:
  - EAP-TTLS/CHAP
  - EAP-TTLS/MS-CHAP
  - EAP-TTLS/MS-CHAPv2
  - EAP-TTLS/PAP

- EAP-TLS
  EAP-TLS (Extensible Authentication Protocol Transport Layer Security) requires digital certificate authentication both at a client and an authentication server.
Encryption methods

- TKIP
  TKIP (Temporal Key Integrity Protocol) provides a per-packet key mixing a message integrity check and rekeying mechanism.

- AES
  Advanced Encryption Standard (AES) provides stronger data protection using a symmetric-key encryption.

- CKIP
  The original Key Integrity Protocol for LEAP by Cisco Systems, Inc.

When [Communication Mode] is set to [Infrastructure]

<table>
<thead>
<tr>
<th>Authentication Method</th>
<th>Encryption Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>LEAP</td>
<td>CKIP</td>
</tr>
<tr>
<td>EAP-FAST/NONE</td>
<td>TKIP+AES / AES</td>
</tr>
<tr>
<td>EAP-FAST/MS-CHAPv2</td>
<td>TKIP+AES / AES</td>
</tr>
<tr>
<td>EAP-FAST/GTC</td>
<td>TKIP+AES / AES</td>
</tr>
<tr>
<td>PEAP/MS-CHAPv2</td>
<td>TKIP+AES / AES</td>
</tr>
<tr>
<td>PEAP/GTC</td>
<td>TKIP+AES / AES</td>
</tr>
<tr>
<td>EAP-TTLS/CHAP</td>
<td>TKIP+AES / AES</td>
</tr>
<tr>
<td>EAP-TTLS/MS-CHAP</td>
<td>TKIP+AES / AES</td>
</tr>
<tr>
<td>EAP-TTLS/MS-CHAPv2</td>
<td>TKIP+AES / AES</td>
</tr>
<tr>
<td>EAP-TTLS/PAP</td>
<td>TKIP+AES / AES</td>
</tr>
<tr>
<td>EAP-TLS</td>
<td>TKIP+AES / AES</td>
</tr>
</tbody>
</table>

User ID and password

The following security methods support a user ID less than 64 characters and a password less than 32 characters in length:

- LEAP
- EAP-FAST
- PEAP
- EAP-TTLS
- EAP-TLS (For user ID)
General Procedure for the P-touch Template Function

The general procedure for using the P-touch Template function is described below. For more information on specifying the various settings, see *Print Labels Using P-touch Template* on page 50.

Before connecting the Barcode Scanner to this Label Printer, make sure that the Barcode Scanner settings match the settings in the P-touch Template Settings tool that is specified during preparation. For more information, see "Preparation" on page 51.

1. Use P-touch Editor to create a template and then transfer it to the Label Printer.
2. Connect the Barcode Scanner to the Label Printer.
3. Scan the *P-touch template command* barcode to specify new settings or clear the previous settings.
4. Scan the *Basic settings* barcode to specify the setting you want.
5. Specify the appropriate settings (A, B, or C).

**A. Standard Template Printing**
1. Scan the *Preset template number* barcode.

**B. Advanced Template Printing**
1. Scan the *Select template* barcode, and then scan the barcodes under *For entering numbers*.
2. Scan the barcode whose data you want to use or copy.
3. Scan the *Begin printing* barcode.

**C. Database Lookup Printing**
1. Scan the *Select template* barcode, and then scan the barcodes under *For entering numbers*.
2. Scan the key barcode for the database data.
3. Scan the *Delimiter* barcode.
4. Scan the *Begin printing* barcode.

6. The specified label is printed.
List of Barcodes for Specifying Settings

For more information about using these barcodes for specifying the Label Printer settings, see Print Labels Using P-touch Template on page 50.

**Note**

- When using the barcodes in this list, set **Trigger for P-touch Template Printing** and **Command Prefix Character** to the factory settings in the P-touch Template Settings tool.
- Make sure you print the barcodes at a high resolution so that the barcode scanner can read them correctly to print the labels you want.

- **P-touch template command (initialize + begin specifying settings)**

- **Basic settings**

  - **Auto cut on (Cut every one label) + Cut at end on**
    - Barcode: ![Barcode Image]
  - **Auto cut off + Cut at end on**
    - Barcode: ![Barcode Image]
  - **Give priority to print speed**
    - Barcode: ![Barcode Image]
  - **Number of copies**
    - Barcode: ![Barcode Image]
List of Barcodes for the P-touch Template Function

- For entering numbers

  1
  2
  3
  4
  5
  6
  7
  8
  9
  0
  00

- Preset template number

  Preset template 1
  Preset template 2
  Preset template 3
  Preset template 4
List of Barcodes for the P-touch Template Function

Preset template 5

```
^T5005^FF
```

Preset template 6

```
^T5006^FF
```

Preset template 7

```
^T5007^FF
```

Preset template 8

```
^T5008^FF
```

Preset template 9

```
^T5009^FF
```

Preset template 10

```
^T5010^FF
```

- **Select template**
  
```
^TS
```

- **Number of serialized copies**
  
```
^NN
```

- **Delimiter**
  
```
^ID
```

- **Begin printing**
  
```
^FF
```

---

1 These are used when specifying the number of copies printed and when selecting a template number. Scan barcodes to specify a three-digit number, such as [0][0][7] or [0][1][5]. The setting is automatically applied when three digits have been specified. To change settings, scan the “Number of copies” barcode again when changing the number of copies or scan the “Select template” barcode again when changing the template number, and then scan the barcodes for the new three-digit number.
Use the Brother Barcode Scanner (Optional: PA-BR-001)

P-touch template mode provides operations for inserting data into text and barcode objects in a downloaded template from a Barcode Scanner to the connected Label Printer.

Because the Brother Barcode Scanner (optional: PA-BR-001) has been set according to the P-touch Template Settings in the Printer Setting Tool, you can quickly use this Barcode Scanner without changing its settings.

For information about using the Brother Barcode Scanner, see the instruction manual included with the Barcode Scanner.